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Artec Studio is an industry-acclaimed software package for advanced 3D scanning and
data processing. It enables you to scan countless objects using Artec scanners as well as
third-party 3D sensors (Microsoft Kinect, Intel RealSense and PrimeSense Carmine, etc.)
(Artec Studio Ultimate only). This manual will show you how to use the application as
well as your 3D scanner to quickly and easily create great-looking 3D models.

Use the Documentation Structure outline to get an overview of the entire manual, or refer
to the Quick Start Guide. To get the most out of the documentation, review the various
terms we use throughout. Consult the genindex to find references for specific parameters
that appear in processing algorithms. Also, take a look at the Conventions and Acronyms
page for a key that describes how we highlight semantic elements.

In addition to this manual, you can find practical tips and other information at the Support
Center. If you encounter an issue when using our 3D scanners or applications, please
submit a request.

Documentation for earlier versions of the software is available here.
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CHAPTER 1

3D Scanning at a Glance

Before you start using the guide, we want to show you how easy 3D scanning can be.
Although this well-structured manual covers all the matters related to Artec scanners
and software, you may find it helpful to have an overview at your fingertips. This brief
summary will assist you in getting started right away! But if you prefer to begin with
comprehensive and detailed information, you can skip this chapter.

1.1 Activate

The scanner case includes everything you need to start 3D scanning, except a computer.
At a minimum, your PC must run the 64-bit version of Microsoft Windows 7 or 8 (10 is also
supported). The more powerful the PC, the better. The main memory (RAM) and graphics
card are the most critical components (visit our FAQ page for more information).

Warning: Don’t connect the scanner just yet! Continue reading for more information.

1. Register for an account at my.artec3d

2. Sign in and download Artec Installation Center from the welcome page

3. Install Artec Installation Center. When prompted, enter your email and password.

4. Plug the scanner into a power outlet, then connect it to your PC using the USB cable

5. Wait for Windows to detect the scanner. Click Activate.

6. Click Install in the Software section to get Artec Studio running on your machine

(For more details, see User Account, Scanner Activation and Offline Activation.)

1.2 Prepare

Most objects are easily scannable. Before scanning transparent, reflective or black ob-
jects, we suggest applying a powder coating or a special anti-glare spray.
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To scan monochrome objects with simple geometric shapes, do the following:

• Add auxiliary objects (e.g., crumpled paper) to the scene

• Paint markers (e.g., “X” shapes) on the surrounding surfaces

Be sure to provide good ambient light. (For more info, see Selecting and Preparing Objects
for Scanning.)

1.3 Scan

1. Launch Artec Studio, then aim the scanner at the object.

2. Hit the F7 key or press on the scanner to start Preview mode.

• Geometry + Texture is the default scanning mode and is suitable for most cases

• For older PCs, Geometry mode is a good alternative

• The Real-time fusion mode creates a model in real time, allowing you to skip
postprocessing; click Stop, then select the Real-time fusion checkbox and click
Preview.

3. Make sure the object is visible, then press once again to initiate recording. If
possible, scan all sides of the object in one go, slowly moving the scanner around
it as pictured below.

Note: While scanning, pay closer attention to the object on the screen
than to the actual object.

4. If you hear an alert sound and the screen displays an error against a red background,
smoothly aim the scanner at the area you just captured. Possible reasons for the
“Tracking lost” error include the following:

(a) You are scanning simple geometric shapes

(b) The part of the object you are scanning is too small

(c) Scanner movement is too fast

5. Press to display the scan in the Workspace panel.

1.3. Scan 5
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1.4 Turn and Scan (Optional)

Note: This part is optional.

Turn the object and capture any remaining unscanned regions (press ). Also, to facilitate
alignment, record at least one previously scanned region.

(For more info, see Artec Scanners: Buttons and LED Indicators, Tweaking Scanning Options,
Scanning Procedure, Tracking Modes, and Scanning With Real-Time Fusion.)

1.5 Autopilot

For beginners, the easiest way to obtain a 3D model is by using Autopilot. It’s also a great
time saver for advanced users. If you prefer performing all the steps manually, refer to
the Process Manually section.

Autopilot is a special mode that helps users obtain a complete 3D model without learning
all the ins and outs of postprocessing. It consists of two major parts: semiautomatic
(editing and alignment) and automatic 1.

1 Automatic steps may include the following:

1. Fine registration

2. Global registration

3. Outlier removal

4. Fusion

5. Small-object filter

6. Mesh simplification

7. Texturing

6 Chapter 1. 3D Scanning at a Glance
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Tweaking Autopilot Settings

• Hole-filling method (available options are Don’t fill, Watertight and By radius) in-
structs the algorithm to fill or not fill holes in the model.

• Model resolution—the lower the resolution value, the sharper the shape and the
more details you will see. If you’re unsure, leave the value as Auto. Effectively,
it’s the same as Fusion resolution. Note that the resolution should be no less than
0.5 for scans captured using EVA and no less than 0.1 for Spider.

• Polygon count determines how many polygons the resulting model will have. The
greater the value, the better the quality and the larger the file size. If you’re
unsure, leave the value as Auto. For more information, consult the Mesh Simplifi-
cation section.

• Texture—clear this checkbox if you don’t want to apply texture to the model.

• Texture resolution takes specific values in the range of 512x512 to 8192x8192 or
16384x16384 pixels depending on the available GPU memory.

To produce a model,

1. Click Autopilot in the left panel or hit F9 .

2. Become familiar with the steps that you will perform in this guided mode (listed in
the welcome screen).

3. In theWorkspace panel, use the flag to mark all scans that you intend to use, then
click Next.

4. Then specify the input parameters for the model-creation step and click Next. Pri-
mary settings may include the following:

Note: We suggest consulting the tool tips, which you can reveal
by clicking the button next to the option name.

(a) Scan quality (geometry). Click to determine whether your scan of
the object has the correct geometry by examining the tool-tip images.

(b) Scan quality (texture). Click , look at the images and decide whether
your scan has sufficient texture.

(c) Hard-to-scan surfaces. Select the checkbox if your object has surfaces
that are difficult to capture. Consult the image samples by clicking
the button.

(d) Decide on the Object size by referring to the image samples.

(e) Leave the default values for the remaining options in this window

8. Texture optimization (Texture inpainting)

1.5. Autopilot 7
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(sufficient for most cases). For advanced scenarios, you can tweak
these settings (more details appear in the sidebar).

5. If necessary, erase any extraneous objects that can hinder postprocessing. Learn
how to use Eraser by consulting the Erasing Portions of Scans section.

6. Once you’re done, clickNext. If the object was captured over several scans, Autopilot
will align them and show you the result. You can approve it or align the scans
manually (consult Manual Rigid Alignment Without Specifying Points).

7. Click Next.

8. Autopilot will begin postprocessing 1. Once it’s finished, a message will appear
informing you that the model is ready. Click OK.

1.6 Process Manually

1.6.1 Crop Surroundings

Once you finish, click File and select Save project. Close the Scan panel; preliminary reg-
istration will start automatically. You can then crop the surroundings.

Purpose: To erase auxiliary surfaces (e.g., a table or floor).

Steps: Open Editor → Eraser → Cutoff-plane selection. Follow the instructions.

(For more info, see Editing Scans.)

1.6.2 Align

Purpose: To align several scans. Skip this step if only one scan is in the Workspace panel.

Steps:

1. Mark two or more scans using , click Align and select those scans in the Rigid tab
while holding the Ctrl key.
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2. Click Auto-alignment.

3. If alignment fails owing a lack of texture or lack of overlapping areas, manually
match the features among the scans and click the Align button.

(For more info, see Scan Alignment.)

1.6.3 Global Registration

Purpose: To simultaneously optimize the frame position across all scans, thus preparing
them for further processing.

Steps: Mark scans using , then click Tools→ Global registration→ Apply.

(For more info, see Global Registration.)

1.6.4 Eliminate Noise

Purpose: To erase large outliers and some noise.

Steps: Open Tools→ Outlier removal→ Apply.

(For more info, see Editing Scans and Outlier Removal.)

1.6.5 Fusion

1.6. Process Manually 9
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Purpose: To create a model (a single surface, as opposed to the multiple surfaces that
constitute the source scan).

Steps: Select Tools→ Smooth fusion→ Watertight → Apply.

To obtain sharper surfaces, select Sharp fusion. In both cases, resolution can be adjusted:
the smaller the value, the more precise the resulting surface.

(For more info, see Fusion.)

1.6.6 Erase Flaws (Optional)

Purpose: To erase any outliers and poorly scanned regions.

Steps: Click Editor → Defeature brush. Follow the instructions.

(For more info, see Editing Scans.)

1.6.7 Simplify Mesh

Purpose: To reduce the file size by decreasing the number of polygons without signifi-
cantly distorting the actual 3D geometry.

Steps: Click Tools→ Mesh simplification→ Apply.

(For more info, see Mesh Simplification.)
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1.6.8 Apply Texture

Purpose: To create a textured model.

Steps:

1. Click Texture.

2. Select fusion and its “parent” scan(s) in the corresponding fields.

3. Select Generate texture atlas→ Apply.

(For more info, see Texturing.)

1.7 Measure, Export, Share

• Export the model: open File→ Export mesh. Select the required format, specify the
folder and file name, then click OK.

• Measure the model: open Measures, then select one of the following:

– Linear for distance calculation (points are connected by lines)

– Geodesic for distance calculation (points are connected by curves that pass over
the model surface)

– Sections for area and volume calculation

• Share the model on viewshape.com by opening the Publish toolbar

(For more info, see Exporting Models and Scans, Publishing to the Web and Measurement
Tools.)

1.8 Tips and Tricks

• You can reset all settings to their defaults using F10 → Scan tab→ Reset to defaults

• To return any altered parameters in the Tools panel to their default values, click the
adjacent button. The button indicates a default value.

1.7. Measure, Export, Share 11
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• Save screenshots by hitting Ctrl+Shift+S

• Apply annotations using Measures→ Annotations, enter the tag label and type text,
then click Apply.

12 Chapter 1. 3D Scanning at a Glance



CHAPTER 2

Introduction

2.1 Documentation Structure

The manual is divided as follows:

• 3D Scanning at a Glance (Quick Start Guide) is a brief overview of scanning and pro-
cessing basics. It also covers Autopilot mode.

• Introduction highlights general information on the structure and appearance of the
guide.

• Using the Hardware covers scanner-related matters.

• Installation and First Steps describes how to install the software and start using it.

• Scanning explains the basic principles of object scanning and offers advice on how
to conduct the scanning process to obtain the best results.

• Viewing 3D Models describes ways in which to control an object’s appearance in the
3D View window and obtain the best view of the 3D model.

• Project Operations contains information on datamanagement, working with projects,
exporting and importing data, undoing recent operations, and saving the history of
project changes.

• Data Processing focuses on data-processing techniques: working with separate
scans, alignment, fusion, filters, defect-elimination methods and texturing.

• Additional Modes demonstrates how to publish models on the Web; how to use ad-
ditional features, such as employing several scanners to capture an object; and how
to use measuring tools.

• Settings describes user-adjustable application parameters.

• Scanner Calibration and Correction discusses calibration and correction issues.

• The two appendices comprise a hot-key list and figures illustrating third-party 3D
sensors.

13
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2.2 Conventions and Acronyms

Portions of this user guide are highlighted to draw your attention. For example, important
information appears in boxes. The following examples illustrate our conventions:

•
Note: General information that warrants emphasis.

•
Important: Important information.

•
Warning: Practices to avoid.

• Panel and element names that appear in the application window use italics: e.g.,
Workspace, File and Texture

• Buttons, checkboxes and elements of dropdown lists in panels and application
menus are italicized and underscored: Invert, Apply and so on

• Shortcuts, individual keys and hardware buttons use gray highlighting: e.g., Ctrl
+ A

• Characters that appear in a field, file extension, or directory or file path employ the
following style: Scan 1 , SPROJ , C:\Program Files , and so on.

Note the following abbreviations and icons:

• LMB —left mouse button

• RMB —right mouse button

• —Play/Pause button on the scanner body

2.3 Glossary

The following terms related to Artec Studio and 3D scanning appear regularly in this
manual.

accuracy (general term) How closely a measurement matches the actual value of the
quantity being measured.

Autopilot An advanced smart mode that guides the user through postprocessing in a
few steps, automatically selecting the most effective settings and producing a 3D
model.

bundle Capture of an object through simultaneous use of multiple scanners, whose num-
bers and relative positions are specified in the application.
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CAD model Feature-based, editable solid model used in manufacturing. It can be created
in a CAD system or reverse-engineering software package.

fine registration A thorough frame alignment using an algorithm for relative positioning
of sequential frame pairs.

frames 3D surfaces captured during a scanning session. The maximum scanning rate
is 15 frames per second (30 frames per second for Microsoft Kinect, PrimeSense
Carmine and Asus Xtion sensors).

global registration Algorithm that optimizes the relative positions of all frames using a
single coordinate system.

key frames Frames used by the global registration algorithm. The algorithm selects them
automatically to fully cover the surface of the captured object using as few as pos-
sible.

mesh The surface geometry of a 3D model; it comprises a series of linked polygons.

model The 3D object that results from the fusion operation (in Artec Studio) or another
modeling process in a different software package.

near and far cutting planes Planes that limit the space in which the scanner is capturing
3D frames. The device will ignore everything that is closer than the near cutting
plane or more distant than the far cutting plane.

project A method of managing the scanned material, processed data and user opera-
tion history, either in memory or on disk. Artec Studio project files use the SPROJ
extension.

resolution (general term) The ability of a scanning system to capture detail in an object.

rough registration Preliminary frame alignment performed during capture.

scan A sequence of frames captured in a single continuous movement of the scanner
around an object or scene.

targets Stickers placed on the object being scanned to ease identification of the various
regions. There are two types of targets: non-coded and coded. Unless the type is
explicitly specified, the target is considered non-coded. Typically, a non-coded tar-
get is a round sticker that has a black ring with a white circle in the center; a coded
target has a unique code ring that photogrammetry software can automatically rec-
ognize.

tracking Calculation of the scanner’s position in a coordinate system relative to the scene.

2.3. Glossary 15
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CHAPTER 3

Using the Hardware

3.1 About Scanners and Sensors

Artec Studio can work with one or more Artec 3D scanners. It offers tools to quickly
create 3D models of physical objects. Besides managing the process of capturing objects,
it lets you perform full data postprocessing, optimize mesh tessellations and apply other
operations to obtain a quality 3D model. You can then send the complete model to a CNC
machine or import it to another 3D-modeling application.

Figure 3.1.: Features of Artec 3D scanners: Space Spider (left) and EVA (right).

Most Artec 3D scanners are specifically designed for handheld use, offering light weight
and compact size. Being structured-light 3D scanners, they don’t require you to place any
special targets on the object you’re capturing. Using them is easy—no special knowledge
or skills are necessary. To obtain a complete 3D model, simply scan the object from
different angles and fuse the resulting scans into a single model using Artec Studio.

Depending on the size of the object you’re scanning, use either Artec EVA, Artec L2 or
Artec Spider. The primary difference between these models is the depth and field of
view. They also differ in 3D resolution as well as point accuracy; consult the Artec web
site for details. We recommended choosing the scanner model that’s best suited to the
operations you will be performing:

• Artec L2—full body, monuments, architectural elements

• Artec EVA—full body or body parts, faces, automobile interior, large statues

• Artec Spider—pencils, keys and other small objects; fine details on large objects,
such as architectural ornaments.

17
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Figure 3.2.: Fields of view for various Artec 3D scanners.

You can combine several different scanner types while capturing a scene. In some cases
when capturing complex shapes, this capability increases the scanning rate and enables
you to achieve your desired precision.

3.1.1 About Third-Party 3D Sensors

Note: Artec Studio Professional supports only Artec scanners. To scan using third-party
3D sensors you need Artec Studio Ultimate.

Artec Studio Ultimate can work with the following third-party 3D sensors (see Third-Party
3D Sensors):

• Microsoft Kinect for Windows (v1 and v2)

• ASUS Xtion

• PrimeSense Carmine

• Devices featuring Intel RealSense 3D camera

When using the above-mentioned devices, however, the scan quality will be lower than
what you can achieve with Artec 3D scanners.

3.2 Artec Scanners: Buttons and LED Indicators

3.2.1 LED Indicators

Artec scanners include built-in multicolor indicators. By explaining the meaning of these
indicators, the list below enables you to keep track of the scanning process:

Steady blue—scanner is booting up.

Flashing green—Artec Studio cannot detect a 3D scanner.

Steady green—scanner is connected to the application and ready to use.
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Flashing red—scanner is in Preview mode, or tracking in Recording mode
is lost.

Steady red—scanner is in Recording mode and object tracking is proceed-
ing correctly.

3.2.2 Hardware Buttons

The Artec EVA and Artec Spider 3D scanners have three-position buttons on their bodies:

Figure 3.3.: Scanner buttons: Artec Spider on the left and Artec EVA on the right.

—press this button once to open the Scan panel and start Preview mode; press it once
more to switch to Recording mode. Subsequently, pressing this button will switch
between Preview and Recording.

—press once during a scan to stop the scanning process; press twice to stop scanning
and close the Scan panel.

3.3 EVA Scanners: Hardware Synchronization

Artec EVA is equipped with two jacks designed for 6P6C connectors (RJ12). By creating
a bundle, you can link multiple Artec EVA scanners to each other. The master device is
a leading scanner that sends signals to the next slave device. Each subsequent device is
connected to the previous one sequentially as Figure 3.4. shows. To connect the devices,
you can use a standard phone cable (RJ12 6P6C) or any other cable that uses the conductor
scheme shown in Figure 3.4.. Each scanner should also connect to the PC via USB.

Warning: Only Artec EVA scanners can connect to each other. Do not connect Artec
EVA to a telephone wall port!

3.3. EVA Scanners: Hardware Synchronization 19
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Figure 3.4.: Synchronization scheme.
Jacks on the Artec EVA scanner shown at left and conductors in a 6P6C connector shown at right.
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Installation and First Steps

4.1 System Requirements

Your computer must meet the system requirements to use Artec 3D scanners.

Note: Third-party scanners are only available in Artec Studio Ultimate!

In addition, take note of the following:

Real-time fusion mode (Scanning With Real-Time Fusion): ensure that your graphics card
has at least 1 GB of memory or your Intel HD Graphics chipset is 4600 or higher
(consult the FAQ article for more information).

Using Intel RealSense camera requires your computer to run Windows 8 (Windows 10 for
SR300) and to feature at least 4th Generation Intel Core processor and USB3.0

Using Kinect v2 requires your computer to run Windows 8 and to feature 3.1 GHz (or
faster) processor with physical dual-core (2 logical cores per physical) and USB3.0
based on Intel or Renesas chipset.

Using multiple scanners (Multicapturing) requires your workstation to integrate as many
independent USB2.0 host controllers as connected scanning devices. Upgrading
your hardware with PCI/PCI Express USB2.0 cards may provide the required number
of hosts.

Stereo mode in Artec Studio: to view models rendered in 3D on stereoscopic displays,
you need an Nvidia Quadro professional graphics card that supports OpenGL Stereo.
Also consult the article.

4.2 User Account

To install Artec Studio and keep it up to date, register for a free account at my.artec3d.
Registration is also required to activate an Artec 3D scanner. In addition, the site allows
you to track all your Artec devices and products.
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Your account at my.artec3d will be valid for all Artec sites and services (including view-
shape.com).

Figure 4.1.: my.artec3d welcome screen.

To register, follow these steps:

1. Go to my.artec3d and click Sign up

2. Fill in all the fields in the registration form and click Create account

3. Receive a registration email that contains a confirmation link.

4. Click the link or copy it to your browser to confirm your registration and go straight
to your my.artec3d account.

4.3 Scanner Activation

Before using your new Artec 3D scanner, you must activate it and link it to an account
at my.artec3d. You can do so with the help of Artec Installation Center—a standalone
utility available for download from my.artec3d. If you’re a new user and don’t yet have
Artec Installation Center, please read Running Artec Installation Center below. Otherwise,
proceed to 3D Scanner Activation Using Artec Installation Center.

Warning: Do not connect your scanner to the USB port before installing Artec Instal-
lation Center.
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4.3.1 Running Artec Installation Center

To use Artec Installation Center, first ensure that your computer is connected to Internet.
Any computer with USB2.0 or USB3.0 ports will work. If necessary, you will be able to
install and activate Artec Studio on a separate computer later. Also make sure that you
already have a my.artec3d account; if not, see User Account.

1. Log into your my.artec3d account and download Artec Installation Center. The link
for the Artec Installation Center executable is available on site’s the main screen.

2. After downloading, open the folder that contains the executable and run it. Fol-
low the instructions on the installation screens. Once Artec Installation Center is
installed, you will see a dialog requesting your username and password. Use your
my.artec3d account to log in as Figure 4.2. shows.

Figure 4.2.: Authentication for Artec Installation Center

4.3.2 3D Scanner Activation Using Artec Installation Center

To activate a 3D scanner using Artec Installation Center, make sure your computer is
connected to the Internet and that you have installed the application.

1. Run Artec Installation Center (go to the Start menu: click Start → All Programs →
Artec Group→ Artec Installation Center) to bring up the window shown in Figure 4.4..

2. Connect your new Artec 3D scanner to the computer and wait until Windows detects
the device and installs the necessary drivers. You may see a notification similar to
one shown in Figure 4.3..

3. Go to Artec Installation Center, click Refresh and wait for the new 3D scanner to
appear in the hardware box (see Figure 4.4.). Click Activate (to the right of the serial
number) to enable your 3D scanner. The status of the device should change to
Activated, as Figure 4.5. shows.
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Figure 4.3.: Windows notification indicating device installation.

Figure 4.4.: Activate button for 3D scanner
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Figure 4.5.: 3D scanner activated

4.4 Artec Studio Installation

There are two ways to download and install Artec Studio:

• Through Artec Installation Center (either during the installation process or by click-
ing Install in the application, as Figure 4.6. shows)

• Frommy.artec3d—log into the site, go to theMy applications page and download the
executable (see Figure 4.7.)

Figure 4.6.: Artec Installation Center is ready to install Artec Studio.

If you download the executable, run it to begin installation; otherwise, click Install in
Artec Installation Center. To continue with the installation, click Next and proceed to the
license agreement (see Figure 4.8.). After reviewing the agreement, accept it by clicking
Yes.

Specify the path to the installation folder (we recommend using the default location) as
Figure 4.9. shows, then select the components you would like to install (see Figure 4.10.):

Program-menu shortcuts —create icon in the Start menu

Desktop shortcut —create icon on the desktop

4.4. Artec Studio Installation 25
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Figure 4.7.: Portion of My applications page at my.artec3d.

Figure 4.8.: License agreement

Figure 4.9.: Installation location
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Figure 4.10.: Select components to install

Figure 4.11.: Third-party 3D-sensor driver selection
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Figure 4.12.: Artec Installation Center showing Artec Studio activation window

Figure 4.13.: Finish installation
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Start-menu shortcut —add shortcuts to the Start menu and Quick Launch
panel

English manual —install user manual in English

Install Artec Scanner Drivers —install drivers for Artec 3D scanners

PrimeSense Carmine / Asus Xtion drivers —install drivers for Prime-
Sense/Asus 3D sensors

By default, the application will create all of the above icons and install the user manual
and Artec 3D-scanner drivers. To continue with the installation, click Next.

If you have yet to install Artec Installation Center, a login dialog will appear, as Figure
4.2. shows. If you are not connected to the Internet, consult Offline Activation regarding
offline activation of Artec Studio.

If you have yet to link to your account the computer on which you are installing Artec
Studio, you will see the activation confirmation shown in Figure 4.12..

When the installation is complete (see Figure 4.13.), the installer will offer to launch Artec
Studio.

4.5 Offline Activation

If the computer on which you are installing Artec Studio lacks an Internet connection for
security or other reasons, you may use the offline activation procedure to activate the
software.

Note: Copies of Artec Studio activated offline cannot be deactivated, so use this option
only if absolutely necessary.

Note: Before conducting offline activation, make sure the scanner (see Scanner Activation)
and Artec Studio are tied to your my.artec3d account.

For offline activation, you need the following:

• Another computer connected to the Internet

• Artec Studio installation package (preferably, download it from my.artec3d)

• Flash drive or another storage medium to transfer files from the Internet-connected
computer to the computer that will run Artec Studio

Installation and activation procedure:

1. Start Artec Studio installation.

2. During installation the login/password dialog will be displayed as Figure 4.14.
shows. Click Activate offline
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Figure 4.14.: Artec Installation Center authentication dialog

Figure 4.15.: Offline-activation window
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3. In the offline-activation dialog (Figure 4.15.), click Save... and save generated Acti-
vation ID file to a flash drive or other storage medium.

4. Log into your my.artec3d account and open My applications page using the Internet-
connected computer.

5. Find Artec Studio and click on it. A new page will appear, as Figure 4.16. shows.

6. Click the Activate application offline link then the Select file button and specify the
Activation ID file path. Next, click Activate.

7. A new dialog will allow you to download an Offline Activation Data file; save it to
the flash drive.

8. Return to the computer on which you are installing Artec Studio. Click Activate and
Continue and specify the Offline Activation Data file.

Note: Once you create the Offline Activation Data File, my.artec3d will decrease the
number of available activations by one.

Once you complete all the steps described above, your copy of Artec Studio will be acti-
vated and all of your Artec 3D scanners will be installed on the non-Internet-connected
computer.

Figure 4.16.: Offline activation at my.artec3d.

Note: If later you purchase another Artec 3D scanner, you must reinstall the application
and repeat the activation procedure described above to copy the new scanner’s data files
to your computer.

4.6 Deactivation

Note that deactivation is only possible for computers on which you activated Artec Studio
online as Artec Studio Installation describes. Artec Studio installations activated offline
cannot be deactivated.
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Note: The number of deactivations may be limited, so deactivate Artec Studio only if you
absolutely must move it from one computer to another.

Figure 4.17.: Deactivation of Artec Studio.

To deactivate a license on your computer, follow these steps:

1. Make sure the computer is connected to the Internet.

2. Go to Control Panel→ Uninstall Applications and click on Artec Studio. The uninstal-
lation process will start.

3. The dialog shown in Figure 4.17. will appear. Select the I understand. Deactivate
Artec Studio on this computer checkbox.

4. Click Next to complete the uninstallation.

4.7 Managing Artec 3D Scanners and Products

Artec Installation Center manages applications and 3D scanners linked to your account.

It’s a multifunctional supplement to Artec Studio that connects with my.artec3d and helps
you install new applications, download updates and manage your 3D scanners. To launch
Artec Studio for the first time, you must log into my.artec3d. After this one-time authen-
tication, you need not provide your username or password each time you launch the ap-
plication.

When Artec Studio launches, Artec Installation Center checks for new updates; if an up-
date is available for any installed product, the software will display a notification like the
one shown in Figure 4.18..

Once you log in, Artec Installation Center displays information about your products.

The Software section of Artec Installation Center provides all information about your soft-
ware products:
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Figure 4.18.: An Artec Studio update is available for download.

Figure 4.19.: Artec Installation Center.

• A list of all applications available to you

• Activation status of each application (application may or may not be activated)

• Total number of activations and number of activations you’ve used so far

• Activate, Install or Update buttons for any of these actions that are currently available
to you

– Install—appears if the software is not installed on the computer (installation
usually means activation)

– Activate—appears if the software is not currently activated on the computer.
Activation decreases number of licenses by one for each computer.

– Update—appears if a new version of installed software is available for down-
load

The Hardware section contains a list of the scanners that you own or have otherwise
connected to your computer. For the first case, the Activated status or Activate button will
be displayed, while in the second case, the Rented status or Rent button will be displayed.

A row of buttons appears at the bottom of the Artec Installation Center window:

Refresh —refresh the data displayed by Artec Installation Center

Close —exit Artec Installation Center
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4.8 Getting Started With Artec Studio

4.8.1 Main Window

You can launch Artec Studio in several ways:

• Click the desktop icon

• Using the Start menu, click Start → All Programs→ Artec Group→ Artec Studio Pro-
fessional/Ultimate 11.

When you launch Artec Studio, you will see the main application window, which allows
you to perform all operations on scans and models. The main window is divided into sev-
eral sections (see Figure 4.20.): 3D View, Side panel, Left panel (figure depicts optionally
open Tool panel), Workspace and Log as well as menu bar and status bar (not marked in
the figure). Other windows may appear temporarily as well.

Figure 4.20.: Main window of Artec Studio.

The 3D View window displays all 3D data. You will use this window regularly. When the
application launches, a coordinate grid with coordinate axes will appear in the center.
Your scans and models will employ this global coordinate system.

To the left of the 3D View window is a side panel that contains icons for various application
modes, including Scan, Autopilot, Editor, Tools, Align, Edges, Measures, Multi, Texture and
Publish. These modes are mutually exclusive: the application can work only in one of
them at any given time, except for Autopilot. Some modes will lock the Workspace panel
when you use them. The main application modes are Scan, Autopilot, Editor, Tools and
Align.

At the top of the 3D View window is a context-dependent 3D Tools panel containing
the following commands: Home, Fit to view, Grid, Lighting, Color, Render mode, Shading
and Backface. Editor mode includes several additional tools: Select through, Positioning,
Move/Rotate/Scale, Smoothing brush, Eraser, Defeature brush and Texture-healing brush.

TheWorkspace panel displays and manages all data uploaded to the application. Here you
will find your scans as well as project-manipulation commands, such as saving, erasing,
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moving and renaming. You can reveal the hidden Workspace panel by clicking at the
top right of the 3D View window (see Figure 4.21.).

Figure 4.21.: Button to reveal Workspace panel.

The Log panel sits at the bottom of the application window. The log is the software’s
report on any executed commands, specifying the time and details of each operation. It
also stores all error and troubleshooting messages generated by the algorithms.

The status bar contains information on memory availability and current usage by Artec
Studio. It also has a progress indicator for any currently running task, such as algorithm
execution, model and scan exporting, and so on.

4.8.2 Primary Settings

To access the settings dialog, select Settings... in the File menu. The settings window has
several tabs for various groups of application settings. To switch between the tabs, click
the icon at the top of the dialog. For a detailed description of the tabs, see Settings.

Figure 4.22.: Language selection through Settings.

Under the Performance tab you can specify the maximum number of alterations to be
saved, or specify maximum the size (in MB) of the history to be saved. The Data-
compression level slider enables you to adjust the compression level when saving project
data to a disk.
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To change the language, select the Miscellaneous tab (Figure 4.22.) and then the required
language from the list and click OK. You will be asked to confirm the operation and restart
the application. Once you agree, Artec Studio will automatically restart using the new
interface language, but you will lose all unsaved data. If you choose not to restart, the
changes will be applied the next time you start the application.
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Scanning

5.1 Scanner Buttons and Capture Modes

Your 3D scanner may be in one of the following capture modes (each of which has a
corresponding color and flicker rate of the LED indicator on the device if you’re using an
Artec scanner):

Figure 5.1.: Understanding capture modes (colors correspond to scanner LED indicator
colors).

Idle—the LED is steady green . This mode indicates either that the application has de-
tected the scanner or that the user has clicked the Stop button in the Scan panel
or pressed the button on the scanner body (see Figure 3.3.). In this case, the 3D
scanner is not flashing.

Preview—the LED is flashing red . In this mode, the 3D scanner is capturing images,
but the software is neither performing alignment nor recording captured frames.
To start this process, either click the Preview button in the Scan panel (see Figure
5.13.), press the button on the scanner body or hit the F7 key on the keyboard.
This mode is useful when doing the following:

1. Checking the 3D scanner’s field of view

2. Determining the best position for the object

3. Preparing to recording and developing a scan procedure

4. Adjusting texture brightness
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Recording—the LED is steady red Scanning takes place in thismode, with the software
storing 3D data to disk or RAM. Activate this mode either by clicking the Record
button in the Scan panel, hitting the Space key on the keyboard or pressing the
button (do so once for Preview and a second time for Recording). To pause recording,
either click Pause in the Scan panel, press on the scanner body or hit the Space
key.

5.2 Selecting and Preparing Objects for Scanning

Artec 3D scanners employ is based on the structured-light method of 3D reconstruction.
Since they capture 3D frames using optical technology, some types of objects are difficult
to scan. Certain techniques, however, enable successful scanning of such objects. For
example, you can cover a transparent or dark object with a light paint or dust it with
talcum powder. You can also use other easily removable substances or a special anti-
glare spray.

Table 5.1.: Hard-to-scan Surfaces

Surface Features Possible Solutions
Black or very dark Dust with anti-glare spray
Shiny or reflective objects Dust with anti-glare spray tilt scanner when

capturing
Transparent (glass, certain
kinds of plastic, etc.)

Dust with anti-glare spray

Thin edges Add background geometry (e.g.,
crumpled paper)

5.3 Technique

Artec 3D scanners capture objects at a rate of 15 frames per second to ensure that adjacent
frame areas overlap as you gradually move the scanner. Artec Studio uses features in
overlapping areas to automatically align captured frames. It performs this task in real
time, providing immediate access to the frames in a single coordinate system. You can
evaluate the captured area after the scanning session to determine which parts of the
object require additional scanning.

To accurately capture an object or scene, follow these steps:

1. Pay closer attention to the object on the screen rather than looking at the actual
object.

2. Ensure that Artec Studio can accurately register frames from the scanner. To this
end, do the following:

• Don’t move the scanner too fast

• Keep the object as close to the center of the field of view as possible
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Figure 5.2.: Scanner orientation and reconstructed surfaces.

Figure 5.3.: Distance meter in 3D View window showing surfaces that fall within the op-
timal range for Artec EVA.
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• Maintain the scanner orientation in such a way that the field of view is suffi-
ciently filled with surfaces (see Figure 5.2.)

• Try to position the scanner as close as possible to the center of the range meter
1 or a little below it (closer to the object; see Figure 5.3.)

3. If you’re capturing an object over several scans, remember to capture a common
area in each one to ensure successful alignment

4. If you’re capturing an object in one scan, do so all the way around the ob-
ject—regardless of direction—plus a little more (360+ degrees)

5. Avoid capturing any objects that may change shape during the scanning process.
When the geometry of the scene is changing, the system may fail to find the correct
position of new frames relative to previously aligned ones. If you have captured
unwanted objects, you must remove them later during the editing stage (see Editing
Scans).

6. Don’t record too many frames: ensure that you have sufficiently scanned all re-
gions, but avoid scanning them twice, except when providing overlapping areas for
subsequent alignment.

5.4 Scanning Procedure

Ins and Outs

• Artec Studio creates a new scan in the Workspace panel at the beginning of each
session.

• When you start Preview mode, Artec Studio will hide all uploaded scans. This
mode helps you to determine how well the 3D scanner sees the object, and it
helps you to identify areas that may cause trouble during the scanning session.
To begin the scanning process, click the Record button in the Scan panel or press
the button on the device body.

• If your 3D scanner is equipped with a texture camera, Artec Studio will activate
the scanner’s texture flash and capture color images that it will later use to texture
the 3D model.

1. Prepare the object and make sure it has enough geometry and texture details (see
Selecting and Preparing Objects for Scanning).

1 Technically, the center of the range meter is the center of the depth of view. The 3D scanner has
near and far cutting planes (see Figure 3.2.) that determine the optimum distance between the scanner
and the target object. Artec Studio offers the Range meter feature so you can easily visualize the distance
between the scanner and the object during the recording process. The Range meter comprises a set of
semitransparent diagrams located on the left side of the 3D View window (see Figure 5.3.). Each histogram
displays the distribution of captured surface points by distance from the scanner. The color corresponds to
the set of surfaces from which it was obtained: by default, gray indicates registered key frames, light green
indicates the last few frames of a registered sequence, dark green indicates the last successfully registered
frame and red indicates a registration error.
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2. Provide even lighting without using direct sunlight.

3. If you have connected just one 3D scanner to the computer, Artec Studio will se-
lect it automatically; otherwise, you must select the appropriate device from the
dropdown list under the Advanced section of the Scan panel.

4. Create a new project before getting started: use the button in the Workspace
panel, select File → New project from the menu, or use the shortcut Ctrl + N .
Once you have saved the project, you will be able to load or unload the scans as
necessary and thereby limit RAM usage (see Project Operations for details).

5. Decide howmany sessions you need in order to capture the entire object. By using a
special third-party rotating table, you may be able to avoid interrupting the session
and eliminate the need to turn the object by hand. Depending on your choice, you
may

• Turn the object

• Position yourself to gain access to the other area

• Use a rotating table

6. Click Preview or press on the scanner. Direct the scanner at the object and practice
your movements around the object, taking into account the proper Technique.

Note: If you wish to use the Enable automatic base removal option, first
direct the scanner at the surface that supports the object.

7. Click Record to start capturing.

8. Gradually move the scanner while monitoring the process in the 3D View window

9. Capture what you can and pause or cease recording by clicking the Pause or Stop
button, respectively. Choose Stop if you must make adjustments to the object’s
positioning (see the next step).

10. Turn the object or otherwise adjust it as necessary, then capture any remaining
unscanned regions.

11. Once you have successfully captured the object from all sides, click the Stop button
or press on the scanner body.

5.5 Tracking Modes

Ins and Outs

• Artec Studio still records texture in Geometry tracking mode if the scanner incor-
porates a texture camera
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• Continuous scanning in the hybrid tracking mode is easier with the Scan using
auto-alignment option.

The software provides three tracking modes and one option:

Geometry + Texture, or hybrid The optimal (and default) algorithm for 3D scanners
equipped with a texture camera. It uses features from images obtained using the
texture camera as well as geometrical features of the object and thus is more likely
to successfully capture flat or textureless objects. The only possible drawback is
greater CPU utilization compared with other algorithms, potentially decreasing the
frame rate for less powerful computers. You can use this mode with Artec MHT,
Artec EVA, Artec Spider and third-party 3D scanners.

Figure 5.4.: Texture tracking renders color object (scanner’s current field of view outlined
in green).

Geometry The default algorithm for all 3D scanners that lack a texture camera (Artec EVA
Lite). It uses only object geometry to align the scanned frames, making it suitable
for objects that have a rich geometry but not objects with large flat, spherical or
cylindrical parts. The Geometry tracking algorithm is the least CPU hungry.

Targets A special algorithm for scanning objects with special targets placed on their sur-
faces.

Real-time fusion (option) Available for both Artec 3D scanners and third-party 3D sen-
sors, this option fuses the results immediately after scanning.

See also:

Tweaking Scanning Options

5.5.1 Base Removal: Erasing a Supporting Surface
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Figure 5.5.: Main window when using Geometry tracking to scan objects.

Ins and Outs

• Base removal is available for all tracking modes.

• If you click Stop or press , you should again identify the supporting surface.

• If the scene remains changed, you can also use the Continue Scanning From Scans
Selected in Workspace option. In this case, the application won’t prompt you to
identify the base.

• If base detection is successful, the base will always render in Recording mode.

When you capture an object, you can often omit from the scan any surface that supports
the object. The Base removal option serves this purpose. To employ this option, first indi-
cate the surface onwhich the object is resting and then capture the object. If this approach
is unsuitable for your situation, clear the Enable automatic base removal checkbox.

1. Open the Scan panel.

2. Make sure the Enable automatic base removal checkbox is selected.

3. Click Preview and direct your scanner at the surface that supports object (e.g., a table
or the floor). A gray wireframe plane will appear, indicating the scene’s base.

4. Once the application detects the base, it will display a message: “Now scan the
object.”

Important: If Artec Studio fails to detect a supporting surface, you can
still start recording.

5. Direct the scanner at the object and click Record ( )

6. Scan the object freely. You can pause and resume the session as necessary.

7. Click Stop; all scans will move to the coordinate system with the Z axis normal to
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the base.

8. Close the Scan panel. After Artec Studio performs Fine registration, the Base removal
algorithm will remove the previously detected supporting surface.

Figure 5.6.: Scanning with the Enable automatic base removal option.

5.5.2 Resuming Scan After Lost Tracking

Artec Studio records adjacent frames on the basis of common surface features. If the scan-
ner stops recognizing common features, it will stop capturing the scene. This situation
is called lost tracking; if it happens, just direct the scanner at a recently captured region.
There are, however, nuances, which we address below.

Table 5.2. lists several causes of lost tracking. The most common is moving the scanner
too fast.

Table 5.2.: Causes of lost tracking.

Reason Possible Solutions
Moving the scanner too fast Move the scanner more slowly or increase the

Scanning speed
Scanner sees too few surfaces Increase Sensitivity, apply an anti-glare spray or

direct the scanner at a larger part of the object
Object doesn’t have enough
features for successful
tracking

Apply masking tape or draw markers on the
surrounding surfaces, and/or move the scanner more
slowly

The Scan using auto-alignment option may ease the process of resuming tracking (this
option is enabled by default in the application settings). Note the following:
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Figure 5.7.: Alert message: tracking lost.

• Artec Studio switches almost instantly from displaying Tracking lost mode (see Fig-
ure 5.7.) to Searching for position, which appears on a green background.

• To continue scanning, direct the scanner at a region you’ve already captured.

– Try to maintain the original scanner orientation toward this region

– You need not necessarily use the most recent one, but it should have sufficient
texture features.

• If the application successfully resumes tracking, it will start recording in a newly
created scan. This new scan will already be aligned with the previous one.

The Scan Using Auto-Alignment section describes system behavior when this option is
disabled.

5.5.3 Continue Scanning From Scans Selected in Workspace

Auto-alignment is a great timesaver and may help simplify further processing. But for
projects that involve scans using Geometry + Texture tracking and for which the actual
scene is unchanged, you can continue scanning immediately:

1. Ensure that the Scan using auto-alignment option is turned on in Settings (see Cap-
ture).

2. Mark previously captured scans using the icon in the Workspace panel.

3. Select Geometry + Texture tracking as well as the Continue scanning from scans se-
lected in workspace checkbox in the Scan panel.

4. Click Preview, direct the scanner at a textured region you’ve already captured tex-
tured region—maintaining the original scanner orientation—and then click Record.

5. If tracking resumes successfully, Artec Studio will align the newly recorded scan
with the selected ones.

5.5. Tracking Modes 45



Artec Studio, ver. 11

5.5.4 Scanning With Real-Time Fusion

Real-time fusion is a special mode in which Artec Studio builds a 3D model in real time
while you’re scanning. It’s the easiest and fastest way to obtain a model, but it cannot
completely replace the normal workflow for processing raw scans after capturing them.
Thus, we recommend avoiding Real-time fusion in the following cases:

• The scene is large and the amount of GPU memory is limited

• Objects have complicated shapes that cannot be captured in one scan session

• The object has small geometric details

• Extra-high accuracy is required

The Real-time fusion feature is available for each tracking method.

1. Open the Scan panel.

2. Select the required tracking mode.

3. Select the Real-time fusion checkbox 2.

4. Click Preview and then Record. Observe the recommendations in Scanning Procedure.

5. Pause and resume the session as necessary.

6. When you stop scanning, theWorkspace panel will add one or more raw scans named
Scan1 , Scan2 , Scan3 and so on, as well as one model named Scan1-Fusion
. The number of these raw scans corresponds to how many times you pause and
resume scanning (see Figure 5.8.).

Figure 5.8.: Workspace panel after using Real-time fusion.

You can access the Settingswindow and use the Performance tab to configure the following
Real-time fusion settings (see Real-Time Fusion Settings):

Voxel size 3D resolution of the model (i.e., the size of the triangulation-grid step in mil-
limeters). The smaller the value, the more geometric details you can detect and
capture in 3D.

2 If you selected the Targets mode and cleared the Disable hybrid tracking for .obc checkbox (see the
Photogrammetry Settings section), Artec Studio will clear the Real-time fusion checkbox because it doesn’t
support this combination of options.
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5.5.5 Target-Assisted Scanning

Generally, you don’t need any special equipment to record using an Artec scanner. If the
object has hard-to-scan regions, however, targets may be useful. In some cases, they can
improve tracking and further registration.

Placing Targets

Whatever the method chosen, you should place at least non-coded targets on the object.

Attach non-coded targets (Figure 5.9.) to the object using the following rules:

• Try to place them on flat elements

• Avoid uneven surfaces

• Avoid obstructing significant geometric elements

Figure 5.9.: Non-coded targets placed on an object.

Note: You can specify the target size in the Settings dialog of Artec Studio, as Photogram-
metry Settings describes. If you use non-coded targets from the Scan Reference kit, specify
5 mm for the inner diameter and 10 mm for the outer diameter. You should measure
targets from other suppliers and specify both diameters in the appropriate fields of the
Settings dialog.

Place coded targets if your choice is photogrammetry (Using Photogrammetry Solution
(Scan Reference)).

1. Prepare the objects and surrounding scene. All objects must remain stationary dur-
ing measurement and capture.

2. Place the cross (Figure 5.11.) on the scene, ensuring that it rests firmly, and it is
seen from most points of view. Also double check that all targets on the cross are
clearly visible.

3. Place the coded targets on the object and the surroundings. Note that you should
distribute them such that at least six to eight coded targets are visible in each image.
Random placement is preferable; avoid symmetry and target alignment.
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Figure 5.10.: Coded targets.

Using Artec Scanners Only

You don’t necessarily need a photogrammetry kit to benefit from targets placed on the
object you’re scanning; Artec 3D scanners can do all the work. This mode employs extra-
hybrid (Geometry + Texture + Targets) tracking and doesn’t require you to upload an OBC
file.

1. Open the Scan panel in Artec Studio. Select Targets under Features to track.

2. Scan the object from all sides

3. Run Global registration

Note: As you scan (without having uploaded an OBC file), the application registers the
target coordinates. You can then save an OBC file and use it in later scanning sessions.
We strongly recommend running Global registration first, however.

Using Photogrammetry Solution (Scan Reference)

By using a combination of special reference targets and photogrammetric measurements,
you can scan large areas in one session, improve the accuracy of captured surfaces and
boost productivity by reducing postprocessing time. The only downside of this method is
the preparation. After scanning, however, you need not align the scanned surfaces, so you
can immediately proceed to Fusion (see the order of postprocessing steps in 3D Scanning
at a Glance).

This synergy of technologies is possible thanks to Artec 3D-scanner and photogrammetry
solutions. Several third-party photogrammetry offerings are available on themarket. Scan
Reference photogrammetry is one example. The Scan Reference kit includes hardware and
software (see Figure 5.11.), a digital camera, a reference-scale cross, non-coded sticky
targets (which Artec Studio uses to match the captured 3D data to the photogrammetric
measurements), and reusable magnetic coded targets (required to automatically carry out
measurements in the Scan Reference software).

To perform scanning using targets, follow these steps:

1. Take several photos of the object from different angles. To determine the appro-
priate number of photos, angles and targets for each image, as well as required
settings for a calibrated digital camera, consult the Scan Reference user manual and
FAQ article. General recommendations are as follows:

1. Take photographs at a distance of 0.5–1.5 meters with enabled flash
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Figure 5.11.: Scan Reference kit
The kit includes (from left to right) coded targets (foreground), a digital camera, a scale cross, a

roll of tape with non-coded targets and a carry case.

2. Each photograph should contain as much targets as possible and each target should
be captured at least in 10 photos

3. Entire cross should be captured in first 10–12 photographs

4. Capture the object from all sides

1. Move the cross and the coded targets away from the scene.

2. Connect the camera to a PC, then transfer and process the photos using the Scan
Reference software. Once the calculations are complete, the software will display
measurement results on the screen. These results can appear as a point table or a
3D model.

3. Save the point model in an *.obc file. This format is the software’s default.

4. Open the Scan panel in Artec Studio. Select Targets under Features to track.

5. Click Load targets from file and specify the OBC file path.

6. Scan the object. When you finish, the software will align all scans.

Important: If you don’t want the texture and geometry features to assist target scanning,
select the Disable hybrid tracking for .obc checkbox (Photogrammetry Settings).

5.6 Using Certain Scanner Types

5.6.1 Notes on Scanning With Spider

Because Artec Spider has smaller field of view and provides higher accuracy in comparison
with Artec EVA, scanning using it can pose difficulties. Consider the recommendations
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given in Technique and also the following:

• Opt for rotating table if possible

• Use a piece of paper with text on it as artificial texture

• Double check that objects don’t change their shape and position

• Try tuning sensitivity in particular cases (see Sensitivity). Avoid extreme values.

We recommend using the Artec Spider scanner only after it reaches its normal operating
temperature. As soon as you plug Artec Spider in or connect it to a PC, it starts warming
up. If you open the Scan panel, you will see two lines that provide the device’s current
and optimal temperatures. Artec Spider will warm up faster when it’s in Preview mode.
The Scan panel also displays additional information about the time remaining until the
scanner reaches its optimal temperature.

Note: Artec Spider can operate at temperatures beyond its optimal range, but the accu-
racy of captured surfaces may be lower.

5.6.2 Notes on Scanning With Third-Party 3D Sensors

Important: Support for third-party 3D sensors is only available in Artec Studio Ultimate.

Third-party 3D sensors (see Third-Party 3D Sensors) are not specifically designed to serve
as 3D scanners. Because they are multipurpose devices made from inexpensive compo-
nents, they can scan objects, but the texture and surface quality is far worse than that of
professional Artec 3D scanners (see Figure 5.12.). The operating ranges and fields of view
for all Artec Studio Ultimate–supported third-party sensors are shown in Figure 12.6..

When using third-party 3D sensors, bear in mind the following:

Providing good lighting is critical because none of the sensors offers built-in flash. Also,
use of these devices precludes the ability to adjust the brightness of the texture
you are scanning, so good lighting is crucial to obtaining a decent model. Avoid
using too much illumination, and avoid using direct light or fluorescent lamps. Intel
RealSense R200 is particularly sensitive to direct sunlight.

When using PrimeSense and Asus Xtion sensors, a special technique can help you cap-
ture surfaces with consistent brightness:

1. Click the Preview button

2. Direct the sensor at the object and hold it for 5 seconds while the sensor adjusts
white balance and exposure

3. Click the Record button

4. Move the scanner slowly to capture the scene

5. While scanning, keep the sensor as close to the object as possible
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Most third-party devices work in the Real-time fusion mode, except for Kinect v2. More-
over, this mode is default for Intel RealSense 3D sensors.

Figure 5.12.: Object captured and processed
(Artec EVA scan on left and PrimeSense on right).

5.6.3 Notes on Scanning With MHT

The flash feature in an ArtecMHT scanner has a very large but limited number of operation
cycles, so ensure that you disable the scanner when it’s not in use. Avoid leaving the Artec
MHT on for a long time when using the maximum capture rate (15 frames per second).
Artec Studio will automatically turn off the Artec MHT after five minutes of continuous
operation. Normally the active mode/rest mode is 3 minutes of scanning and 7 minutes
of rest; this mode is optimal and significantly increases the lifetime of the flash.

5.7 Tweaking Scanning Options

5.7.1 Tuning Texture Brightness

Note: This option is available only for Artec 3D scanners equipped with texture cameras.

You can adjust the Texture brightness setting in Preview mode. Use the slider to increase
or decrease the brightness of frames captured by the color camera (see Figure 5.14.). Note
that the texture brightness affects texture quality as well as tracking steadiness. Observe
the recommendations in the Table 5.3..

Table 5.3.: Adjusting texture brightness.

Surface Color Recommendation
Dark or black Increase brightness
Light-colored or white Decrease brightness

5.7.2 Sensitivity

You can tune the Sensitivity of Artec 3D scanners if the application fails to reconstruct par-
ticular surfaces. Increasing this setting enables the scanner to more easily capture black,
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Figure 5.13.: Scan panel in Artec Studio.
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Figure 5.14.: Color-camera brightness adjustment
The brightness is lower on the left and higher on the right (slider positions exaggerated for

clarity).

reflective, translucent and fine objects (such as human hair). The higher the sensitivity,
the noisier the recorded surfaces will be. Higher values may also reduce the scanning
speed.

5.7.3 Frequency for Capturing Texture Frames

Specify the frequency for capturing texture frames by using the corresponding spinner in
the Settings dialog (see Texture-Recording Mode and Figure 10.5.).

5.7.4 Deactivating Scanner Flash

If circumstances prohibit you from using the scanner flash, follow the directions below.

Figure 5.15.: Influence of ambient light on captured results.
On left: flash is turned off; ambient light is poor; results—dark texture. On right: flash is turned

off; lighting conditions are improved; results—good texture.

Note that if you disable the flash, you should compensate by using bright ambient light.
According to our tests, acceptable texture quality is obtainable with the flash disabled if
the surface illuminance is at least 1 000 lux. Compare the models shown in Figure 5.15.,
which were recorded under different lighting conditions.

The following procedure captures the textured model without using the scanner flash:

1. Open the Scan panel and click the Advanced link

2. Turn off the texture flash by selecting the Disable flash bulb checkbox
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3. Use good illumination. Avoid fluorescent lamps.

4. Click Preview and direct the scanner at the object

5. Adjust Texture brightness and Texture exposure time. In most circumstances, values
should be as low as possible, because increasing the brightness also increases a
texture noise, whereas increasing exposure time can blur the texture. Instead of
adjusting sliders, try to further improve the lighting conditions.

6. Capture the scene

7. Perform required postprocessing as described in Data Processing to get a textured
model

8. Adjust texture parameters for this fusion as described in Texture Adjustment. Pay
particular attention to the Hue and Saturation sliders. The Hue slider allows you to
correct unwanted texture color.

5.7.5 Tuning Exposure Time

You can alter texture exposure time in the Preview mode. Adjust this parameter in tandem
with the Texture brightness. Increasing exposure time can blur the texture. Don’t alter the
default value unless it’s necessary.

5.7.6 Disabling Texture Recording

Clear Don’t record texture checkbox if you don’t want to store texture information in your
scans. It is located in the Advanced section of the panel and disengages both texture
camera and texture flash in the scanner. Note that this option is unavailable for Artec EVA
Lite. Don’t forget to select this checkbox once you have completed textureless scanning;
otherwise, next time you want to start regular scanning the hybrid tracking mode could
be unavailable.

Important: Just using the Geometry tracking mode it is still not sufficient for the appli-
cation to don’t record texture. Make sure you clear the eponymous checkbox.

5.7.7 Decreasing Scanning Speed

Artec EVA captures objects at up to 15 frames per second, whereas Artec Spider at 7.5.
Default values ensure comfortable scanning with smooth movements. However, if you
find scanning speed inappropriate, you can decrease it. In this case, Artec Studio will
record fewer identical frames and register them faster. To this end, use the Scanning
speed slider in the Scan panel.
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Important: Decreasing scanning speed may hinder scanning. Don’t use this slider unless
it is absolutely necessary.

5.7.8 Supplementary Settings

Customize scan names and starting number by entering your own values in the Prefix
and Start with fields. The software uses these values to create a scan title in the
Workspace panel (see Figure 8.2., left). You can change the default values Scan
and 1 to, for example, Capture and 14 .

Set backing up scan data to disk Trigger a capture mode that simultaneously records
scanning results to a disk by selecting the Copy scan data to disk checkbox. This
option is enabled when you’re working with an existing saved project (see Saving
a Project) and can be useful when capturing large amounts of data on a computer
with insufficient RAM.

Specify a delay (in seconds) before recording using the Delay before recording spinner un-
der the Advanced section of the Scan panel. The countdown begins as soon as you
click the Record button. To eliminate the delay, set the value to zero.

Decrease specified operating-zone by using the Near (mm) and Far (mm) sliders in Scan
panel. Here you can only decrease range within the specified boundaries.

Specify the operating-zone boundaries (in millimeters) By default, Artec Studio provides
the correct values for the minimum and maximum limits within which the cutoff
planes are to be positioned. These values are different for each 3D scanner model,
and they ensure that you capture good-quality 3D data. If high accuracy is a sec-
ondary concern, you can manually adjust the depth boundaries, allowing you to
capture objects using an Artec L scanner or third-party 3D sensors positioned closer
to or further from the object than is recommended. To do so, select the Override
default depth range checkbox in the Settings dialog in the Scan tab, then specify
new boundaries for the scanning range (For more details about scan settings, see
Capture).

Warning: Custom depth-range settings may reduce accuracy.
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5.8 Troubleshooting

Issue Possible Resolution
Geometry + Texture radio
button missing from Scan
panel.

You were probably scanning without texture. Clear the
Don’t record texture checkbox in the Advanced section.

Final model contains
noticeable noise.

You likely scanned the affected areas improperly, or
the scanner was too far from the object. Rescan those
areas.

Tracking lost error persists. Make sure Scan using auto-alignment is enabled in the
Settings dialog and use Geometry + Texture tracking.
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Viewing 3D Models

6.1 3D Navigation

When you have finished scanning, Artec Studio displays the results in the 3D View window.

6.1.1 Moving, Rotating and Scaling

You can control the observer’s perspective in the 3D View window by moving or rotating
the observation point, or by zooming in or out. Use the mouse to control these effects:

Move move the mouse pointer over the 3D View window. Hold down the left (LMB ) and
right (RMB ) mouse buttons simultaneously, then move the mouse to relocate the
model. You can also use the middle mouse button to perform the same operation.

Rotate move the mouse pointer over the 3D View window. While holding down LMB ,
move the mouse to rotate the model.

Zoom in and out hold RMB and move the mouse. Moving left or up will zoom out,
whereas moving right or down will zoom in. You can also use the mouse wheel
to produce the same effect.

6.1.2 Setting Rotation Center

When you rotate the model, the scene always turns around a certain point—the rotation
center. Artec Studio will display three small coordinate axes at this point (see Figure 6.1.).
When you launch the application, the rotation center will coincide with the origin of the
main axis grid. To change its location, double-click LMB at any point on the 3D model:
the rotation center will move to this point. Setting the rotation center can be useful when
you wish to view a particular object from all sides. In this case, set the rotation center on
the object and rotate the view using LMB .
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Figure 6.1.: Rotation center.

Figure 6.2.: View menu options.
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6.2 Choosing Projections

The Viewmenu (see Figure 6.2.) allows you to choose between perspective and orthogonal
projections when displaying the model in the 3D View window.

Perspective projection is the central projection on a plane produced by direct rays that
focus on one point: the projection center. This method produces a visual effect similar to
human eyesight.

Orthogonal projection is when the projection center resides infinitely far from the plane
of projection; in this case, the projection rays are perpendicular to the observation plane.
This method preserves parallel lines and is more commonly used for measurement (see
Measurement Tools for details).

You can also change projection type in other ways:

• Hit Ctrl + 5 on the main keyboard

• Hit 5 on the extended numeric keypad (numpad)

6.3 Viewpoints

To quickly toggle a camera view between several predefined positions, use the View menu
or the keyboard combinations listed in Table 6.1..

Table 6.1.: Key combinations for switching viewpoints.

Viewpoint Keyboard Extended Numpad
Front Ctrl + Shift + 1 1
Back Ctrl + 1 Ctrl + 1
Left Ctrl + Shift + 3 3
Right Ctrl + 3 Ctrl + 3
Top Ctrl + Shift + 7 7
Bottom Ctrl + 7 Ctrl + 7

6.4 Displaying 3D Models

The toolbar at the top of the 3D View window features controls for data-display modes.
All the commands for viewing and switching between modes are also available in the
View menu (see Figure 6.2.).

The (Home) button (or View menu option of the same name) restores the view to its
original position.

The Fit to view command (the button or Fit to view menu option) automatically fits
the object to the 3D View window.
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To enable or disable the global coordinate-system axes, select the Show grid option in

the View menu, or press the button on the 3D View panel.

6.4.1 Rendering and Shading Modes

The View menu allows you to choose one of the following 3D rendering options for
scanned frames (see Figure 6.3.):

Render solid the most common way to render with a solid fill on all faces using your
selected shading method

Render wireframe display polygonal-mesh edges without applying a solid fill to the faces

Render points display polygonal-mesh vertices

Render wireframe over solid apply a solid fill to the faces and use a different color to dis-
play edges. This method enables you to visually assess the quality of the polygonal
model (see Mesh Simplification for details).

Render points and solid automatically display scans in point view, but display models in
solid-fill view. This mode eliminates the need to switch to another mode in order
to find the best rendering approach for each surface type. It is enabled by default
for the Artec Spider scanner.

You can activate any rendering mode from the 3D View toolbar. Click the button to

enable solid-fill mode, to display the wireframe model, to display a point model,

to display the wireframe over the solid fill and to display the point or solid-fill
model, depending on the selected surfaces.

Figure 6.3.: Available rendering modes.

For some examples of the various model-rendering modes, see Figure 6.4..

Also, you can use the 3D View toolbar (Figure 6.5.) to choose a shading method for the
solid fill (Figure 6.6.), or select one from the View menu:

Smooth shading ( in the toolbar) the color value for each point in a triangular face is
calculated using color interpolation at the vertices

Flat shading ( in the toolbar) all the points on a triangular face are assigned the same
color
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Figure 6.4.: Examples of model using different rendering modes.
Point model on left and wire over solid on right.

Figure 6.5.: Available shading modes.

Figure 6.6.: Smooth versus flat shading (respectively).
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6.4.2 Lighting, Color and Texture

The Lighting on option in the View menu—or the button in the toolbar—toggles the
lighting in the 3D View window. This option may be useful when you must turn the
lighting off to see only the outline of the model or to assess texture quality.

The Texture option in the View menu selects the method for assigning colors to the cap-
tured frames. Artec Studio offers the following methods:

• Texture—displays textured data; otherwise, the software uses the scan’s default
color

• Scan color—displays the default color of the scan

• Surface color—displays each frame in a scan using a different color

• Max error—colors the frames in accordance with their registration quality; red indi-
cates a registration error

You can choose among the above-listed options for assigning colors by clicking the cor-

responding button in the toolbar: , , or , respectively (see Figure 6.7.).
Examples illustrating the different color-assignment options are shown in Figure 6.8..

Figure 6.7.: Methods of assigning colors to frames.

Figure 6.8.: Different color modes for scanned frames.
Individual color for each surface (Surface color mode) on left, highlighting registration errors

(Max error mode) on right.

6.4.3 Back-Face Rendering

Artec Studio offers three methods for rendering a frame’s back face:
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Show assigns the back face the same color as the model

Cull the back face is not displayed

Black renders the back face in black

You can choose the mode from the View menu, or click the , or button, re-
spectively, in the 3D View window (see Figure 6.9.). Black is the default mode.

Figure 6.9.: Back-face rendering options.

See Figure 6.10. for examples that illustrate the different methods of back-face rendering.

Figure 6.10.: Examples of different methods for back-face rendering.
Show back-face mode on the left, hide (Cull) in the middle and Black on the right.

6.4.4 Representation of Normals and Boundaries

The Show normals option in the View menu enables or disables rendering of normals for
each vertex. By default, the normals point away from the model surface and toward the
3D scanner. You can change this direction using the Invert normals command. You can
also switch between modes for displaying normals by hitting the N key with the 3D View
window active.

When working with edges, the Show boundary feature in the View menu allows you to
enable and disable highlighting of the model’s edges. To toggle this feature, hit the B
key with the 3D View window active.

6.4.5 Rendering and Texturing Untextured Polygons

Textured models may have some untextured areas (for instance, the green area in the
middle of Figure 6.11.). The Render polygons without texture option in the View menu
allows you to toggle rendering of such areas.

If the texture of the imported model is smaller than the model itself, Artec Studio can
wrap it to fill the untextured areas (see Figure 6.11. (on right); for details on importing
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Figure 6.11.: Texture rendering for Render polygons without texture and Wrap texture coor-
dinates options enabled or disabled.

Polygons without texture not rendered (left), rendered (middle and right) and Wrap texture
coordinates turned on (right).

models, consult Importing Models and Scans). The wrapping effect is similar to floor tiling
or a repeating wallpaper pattern—that is, the texture repeats periodically. To activate
this option, enable the Wrap texture coordinates option in the View menu.

Note: To display untextured polygons, you must activate the Render polygons without
texture option as described above; otherwise the wrapping texture will not appear (see
Figure 6.11. on left).

6.4.6 Displaying Boundaries of Texture Atlas

Textures applied to 3D models are obviously two-dimensional. You may, however, want
to see the boundaries of each texture element on the actual 3D surface. Artec Studio
can display a texture-atlas file, such as the the middle image in Figure 8.51., with its
boundaries highlighted (see Figure 6.12.). Identifying the way in which the boundaries
lie on the surface may, for example, help you determine whether you must simplify the
model to get better texture application.

To enable boundary display, access the View menu and select Show texture boundaries.
To disable this feature, make sure this menu command is unchecked.

Figure 6.12.: 3D model with texture-atlas boundaries.

Technically, this command also works for textures produced by triangle methods, but it
provides no usable information.
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6.4.7 Stereo Mode

Stereo mode (the Enable stereo mode command in the View menu) is for operations de-
signed to work with stereo displays and stereoscopic-3D-enabled equipment. To enable
this mode, your system must support OpenGL Stereo. The Nvidia Quadro family of profes-
sional graphics cards is one example of such equipment. When stereo mode is unavail-
able, the menu option will be grayed out.

For more information on compatible equipment, see the Nvidia website.

6.5 Saving Screenshots

You can capture surfaces displayed in the 3D View window and save them in a graphics
file. Unlike the conventional system Print Screen command, this option saves only
the contents of the 3D View window (see Figure 6.14.) and ignores any background. It
also captures the following objects with the surfaces:

• Coordinate axes

• Points, lines and planes

• Annotations

• Surface-distance maps and their histograms (see Measurement Tools)

• Measurement results (points, lines and labels)

Figure 6.13.: Example screenshot featuring section

To capture a screenshot, follow this procedure:

1. Select the Save screenshot... option in the View menu, or hit Shift+Ctrl+S .

2. In the dialog, specify the destination folder and file name, then click the Save button.
Artec Studio will save the file in PNG format.

Note: If you save a screenshot using an existing file name, Artec Studio will overwrite
that file without warning. Be sure to specify a unique file name to avoid overwriting other
files.
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Figure 6.14.: Example screenshot featuring sirface-distance map with annotations

Figure 6.15.: Example screenshot featuring linear measurement
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Project Operations

A project encompasses all 3D data obtained by scanning and postprocessing that can be
saved to disk and accessed for later use. In addition, it contains measurement results (see
Measurement Tools). For each project, a corresponding folder contains all project data as
well as a project file describing the structure of that data.

7.1 Creating a Project

We recommend creating and naming a project before you start scanning (see Scanning
Procedure). You can create a new project using the File→ New project menu option. Click
the button at the top of the Workspace panel, or use the shortcut Ctrl + N . Then,
in the subsequent dialog (see Figure 7.1.), enter the project name and specify the path
for the folder to which you want to save your project. While you’re working with a given
project, the header of Workspace window will display its name.

Figure 7.1.: Project-creation dialog.

Creating a project is unnecessary if you don’t plan to process or otherwise use the scanned
material in a future session.

7.2 Saving a Project

You can save your project using the File → Save project menu option, by clicking at
the top of the Workspace panel or by hitting Ctrl + S . For unsaved projects, a project-

67



Artec Studio, ver. 11

creation dialog will appear (see Creating a Project).

Artec Studio saves data incrementally, meaning that if you save an existing project, the
application will only save newly changed or added data.

7.3 Opening a Project

To open an existing project, use the File→ Open project menu option, click at the top
of the Workspace panel or hit Ctrl + O .

Note: Files from Artec Studio versions 8, 9, 10 and 11 are mutually compatible. Earlier
versions, however, may be unable to open projects saved in a later version using the
SPROJ format.

By default, when you open a project, the application will restore it to the state in which
it was last saved (the three scan-loading states include loaded, unloaded and key frames
only—see Selectively Loading Project Data). To load faster by opening the project without
loading any scans, use the Open project (scans not loaded) dropdown menu option under
the button. Alternatively, use the same option from the File menu or hit Ctrl +
Shift + O .

Note: When Artec Studio opens a project, it will determine the amount of available
memory. If the scan you are trying to load requires more memory than is available in your
system, the application will process it as an “unloaded” scan.

7.4 Exporting Models and Scans

When you want to store data for future processing, the best approach is to save the project
as an SPROJ file or to export the data to the SCAN format. Any Artec Studio version can
open the latter format. If you plan to use the data in other applications, however, you
should save scans and individual frames in another format.

You may also need to perform one of the following tasks:

Export one or more scans. Select the Export scans... command. Doing so will save all
frames to folders with names that match the corresponding scan names. An excep-
tion is the SCAN format; in this case, Artec Studio not only stores the frame-by-
frame scan structure, but it does so in a single file.

Export a single surface. The best approach here is to select the Export meshes... com-
mand. If you marked several scans, models or frames using the button, Artec
Studio will suggest merging them.
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7.4.1 Exporting Scans

To export scans:

1. Mark any scans you want to export using the button.

2. Select the Export scans... command in the Filemenu or the corresponding dropdown
menu option using in the Workspace panel.

3. Click the ... button to open and specify the destination folder.

4. Select Scan export format using the eponymous dropdown list (see Figure 7.2.).

5. If the selected format supports textures, also specify the texture format.

6. Select the Apply transformation checkbox, or leave it cleared (for more information,
consult Understanding How Artec Studio Applies Transformations).

7. Click OK.

7.4.2 Exporting Meshes

To export a mesh:

1. Mark one or more models using or select frames in the scan by clicking on them
while holding the Ctrl key.

2. Select the Export meshes... command in the File menu or select the corresponding
dropdown menu option by clicking the triangle near the button in theWorkspace
panel.

3. Click the ... button in the current window.

4. Specify the destination folder, enter the file name, and select the appropriate format
from the dropdown list.

5. Click Save.

6. If required, specify the Texture export format (see Storing and Exporting Color Infor-
mation).

7. Click OK.

See also:

Model Placement

Note: The export process for models and scans runs in the background, so the appli-
cation will allow you to continue working with the scans. The progress indicator for the
export operation will appear at the bottom of the main application window. To abort the
operation, click Cancel in the bottom-right corner.
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Figure 7.2.: Formats available for each command as well as for both commands.

7.4.3 Understanding How Artec Studio Applies Transformations

Artec Studio offers two options for exporting surfaces:

1. Store surfaces using the scanner coordinates and create XF text files that contain
the coordinates calculated during registration. To use this approach, clear the Apply
transformations checkbox.

2. Store surfaces that are relocated to the positions calculated during registration. In
this case, XF files contain no relevant data. To use this approach, select the Apply
transformations checkbox.

Special Aspects of Scan Placement

In most cases when you’re exporting a scan to a common 3D-graphics format, you should
select the Apply transformations checkbox. By doing so, you instruct third-party applica-
tions to display surfaces in the same way that Artec Studio does: that is, with the origin at
the center of mass. If for some reason you need to store a scan in the scanner’s coordinate
system—in other words, with surfaces located at a distance from the origin that is equal
to scanner’s operating range—clear the Apply transformations checkbox.

Technically, Artec Studio saves scans in the scanner’s coordinate system, but it displays
them in a user-friendly manner by placing the origin at the center of mass. The actual po-
sitions of surfaces calculated during registration are stored in text (XF ) files. Therefore,
when you’re importing files using Artec Studio, it makes no difference whether the check-
box was cleared when Artec Studio exported them. It does make a difference, however,
for third-party applications that cannot read XF files simultaneously with 3D geometry.

7.4.4 Storing and Exporting Color Information

You can transfer color information for 3D surfaces in three ways. The most common is
through a texture using a separate bitmap file (see Applying Texture). Another option is
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to save color information in each vertex of a mesh. The third is to assign a small textured
fragment to each polygon. The two latter methods produce no texture files.

Colors stored in a vertex are blended throughout the polygon. As a result, you should
avoid oversimplifying the exported mesh; otherwise, colors blended over a large face
may fail to render true texture information.

Table 7.1.: Formats that support color-information transfer.

Texture stored as a bitmap PLY , VRML (*.wrl ), OBJ , X ,
e57

Model file contains separate texture for each
face

PTX

Formats that support vertex color plyVC , XYZRGB

When exporting texture as a bitmap image, you can select one of the following formats:
PNG , BMP or JPG. PNG format provides the best quality for a given file size thanks to
its lossless image compression. JPG is the most compact format.

7.4.5 Exporting Target Coordinates

If you scan while in the Targets tracking mode using only Artec scanners, you can save an
OBC file containing the target coordinates. Once you finish scanning, run Global registra-
tion, then do the following:

1. Use the button to mark any scans that you captured without having uploaded an
OBC file.

2. Select the Export scans... command from the File menu, or select the corresponding
dropdown menu option using in the Workspace panel.

3. Click the ... button to open and specify the destination folder.

4. Select obc from the Scan export format dropdown list.

5. Click OK. The targets.obc file will appear in the folder you specified.

For more information on the OBC file structure, consult the FAQ.

7.4.6 Exporting to Leios

Artec Studio enables you to export files to Leios by accessing the File menu if the Leios
software is already installed on your computer.

1. Select a model in the Workspace panel

2. Open File→ Export to Leios

3. Then, in Leios, select millimeters as the length unit for the imported files.
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Figure 7.3.: Model exported to Leios

7.4.7 Exporting to Geomagic Design X

Polygonal models created in Artec Studio are insufficient for most design needs. Geo-
magic Design X (formerly Rapidform XOR) is purpose built to create manufacturing-ready
CAD models directly from meshes.

To export a model,

1. Make sure Geomagic Design X is installed on your computer

2. In the Workspace panel, mark one model using the flag

3. Select the Export to Design X command from the File menu

4. Wait for the model in OBJ format to open in the reverse-engineering system.

7.4.8 Exporting to SolidWorks

Artec Studio allows you to export models to SolidWorks by using third-party plug-ins. It
supports the following plug-ins:

• Geomagic for SolidWorks

• DezignWorks for SolidWorks

Note: If you have installed both plug-ins, Artec Studio will use Geomagic for SolidWorks.

To export a model,

1. Make sure SolidWorks and either of the plug-ins are installed on your computer

2. In the Workspace panel, mark one model using the flag

3. Select the Export to SolidWorks command from the File menu
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Figure 7.4.: Model exported to Geomagic Design X

4. Wait for the model to open in the CAD system.

7.5 Importing Models and Scans

Importing is another way to load data into Artec Studio in place of capturing or opening
a project. You can import scan files created in earlier versions of the software, as well as
individual frames, in the following formats: PLY , STL , VRML , OBJ and PTX . To do so,
use the File→ Import... menu option, Ctrl + I or the dropdown menu option for the

button. Next, select a file for importing. You can also drag and drop a file into the
main Artec Studio window, or just double click on it.

Note: The import process runs in the background, so you can continue working with the
scans you’ve already loaded. The progress indicator for the import operation will appear
at the bottom of the main application window. To abort the operation, click Cancel in the
bottom-right corner.

Artec Studio will import frame files as individual single-frame scans. After importing each
scan, the application calculates the key frames for any scan that contains more than one
surface. Also, the application will check the surfaces for defects when the appropriate
setting is enabled (see Surface-Consistency Detection During Import). If it finds defects, it
will show a dialog with a list of defective surfaces once the import operation is complete.
You can then choose which ones should be corrected (see Figure 7.5.).
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Figure 7.5.: Dialog for selecting surfaces to correct.

7.6 History of Project Changes

Artec Studio stores all data changes, so you can undo them later. To undo an operation,
click the button in the Workspace panel, or click to perform the previously undone
operation. You can also use Ctrl + Z or Ctrl + Y . Use the dropdown menu buttons

or , respectively, to undo or redo several operations at once.

When you save a project, Artec Studio stores 3D data together with the history of changes.
You can select the maximum length of the history in the settings window under the Per-
formance tab (see Command History). In addition, the Compact memory button allows you
to save the history of changes on a local drive and thus free up RAM. Also, the Clear com-
mand history button clears the change history, likewise freeing up RAM, and makes the
undo operation for the most recent changes unavailable. To clear the history, you can use
the Edit → Clear history menu option in the main window or hit Ctrl + Alt + H .

7.7 Selectively Loading Project Data

When working with a large data set, you may often find it necessary to free up RAM with-
out deleting any of the project data. To this end, Artec Studio implements a mechanism
for selectively loading scans. You can move to disk any currently unused scans to free
up extra RAM. If a particular algorithm later requires any of the unloaded scans, the ap-
plication will automatically reload them. Frames that are not currently loaded into the
memory won’t show in the 3D View window.

Any scans or frames that are completely unloaded from memory will appear in a gray
italicized font in the Workspace window (see Figure 7.6.).

Note: Before you can change a scan’s loading status, you must save the project.

To change the loading status, select the scans in the Workspace window (using the Ctrl
key), click RMB and then select one of the scan-loading options in the pop-up menu (see
Figure 7.6.):
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Figure 7.6.: Selectively unloading scans.

Table 7.2.: Workspace menu commands and icons

Menu Command Function Icon Appearance
Unload scans Fully unload scans from RAM
Load key frames only Only load key frames into RAM
Load scans Fully load scans into RAM
Load textures Fully load texture images into RAM —
Unload textures Fully unload textures from RAM —

Algorithms may automatically change the loading status of project data in the following
cases:

You have selected unloaded scans for processing by clicking the button. Artec Studio
will load these scans into memory.

Execution of the algorithm requires large amounts of memory. Artec Studio will unload
unused scans, frames, textures or a combination thereof.

Note: In addition to 3D data, the change history can also consume a large portion of
memory. For information on how to control the history size as well as how to unload or
clear it, consult History of Project Changes.

7.8 Autosaving a Project

A project can be saved by either the user or Artec Studio. The latter case is called autosav-
ing. For temporary (i.e., unsaved) projects, autosaving is unavailable. The application
autosaves a project in the following cases:
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• Before running the texturing algorithm (see Texturing)

• When scanning is complete and the Backup scan data to disk option is selected (see
Scanning Procedure)

• When unloading scans with unsaved changes (see Selectively Loading Project Data)

• When the Save project before starting algorithms setting is selected (see Autosave
Options):

– Before launching algorithms from the Tools panel

– Before and after running the Global registration algorithm (Global Registration)

– Before starting Autopilot (Autopilot).
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CHAPTER 8

Data Processing

Once you have captured an object from all desired angles and created a sufficient number
of scans, you can then build a 3D model. This chapter offers a detailed description of the
process. Most of the examples herein use a decorative plastic duck figure as the test
object (see Figure 8.1.).

Figure 8.1.: Target object: a decorative duck figure.

The process of creating the final model includes the following stages:

See also:

3D Scanning at a Glance.

• Revising and editing the data (Revising and Editing Scans)

• Scan alignment (Scan Alignment)

• Global data registration (Global Registration)

• Fusion of data into a 3D model (Fusion)

• Final editing of the 3D model (Editing Models)

• Texturing (Texturing)

8.1 Revising and Editing Scans

After each scanning session, Artec Studio saves the sequence of frames as a separate scan.
The list of all scans for a given project appears in the Workspace panel (see Figure 8.2.).
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Data in the Workspace panel is arranged in several columns:

Selection flag —scans marked with a in this column will appear in the 3D View window
and will undergo processing by all Artec Studio algorithms and tools.

Color —in this column, each scan has a colored square next to it. The square’s fill depends
on the number of scan frames loaded into the application. When all frames are
loaded, the square will be completely filled in. When only key frames are loaded,
it will be half filled, and when all the scan data is unloaded, it will be unfilled (see
Selectively Loading Project Data). You can change the scan color by clicking on the
corresponding square and selecting the desired color from the palette.

ID —ID number of the scan.

Title —when a scan is created, Artec Studio automatically assigns it a name, such as
Scan1, Scan2 and so on, according to the values in the Prefix and Start with fields
in the Scan panel. To rename a scan, select it by left-clicking on its name. Then
either hit F2 or right-click on the scan name to open the dropdown menu. Select
the Rename... option. Both approaches open a dialog that allows you to specify the
new name.

Loaded —number of scan frames loaded into memory (see Selectively Loading Project
Data).

Total —total number of frames and size of a particular scan (in MB).

Max error —the largest registration-error value among all frames in the scan.

Figure 8.2.: Workspace panel: scan list (original view) on left and surface list on right.
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8.1.1 Selecting Data

Selecting Scans

Note: To view a scan in the 3D View window or to process it using a tool, first mark it
with the icon.

Purpose Method Alternate Method
Select scan in Workspace Left-click on the scan

name
—

Display scan in 3D View
window and activate it for
processing

Left-click in the empty
area of the leftmost
column

Select scan name using
Shift + Alt + LMB

Hide scan in 3D View window
and deactivate it for
processing

Left-click on icon Select scan name using
Shift + Alt + LMB

Batch selection (deselection)
of scans for display and
processing

Click Hit Ctrl + A (Ctrl + D
)

Select a single scan for
processing and deselect
others

Select the scan name
using Ctrl + Alt +
LMB

Use Ctrl + LMB in the
empty area of the leftmost
column

In addition to the methods in the table above, you can use commands from the dropdown
menu of the button. See also the full list of hot keys in Hot Keys.

Selecting Frames

Double-clicking the scan name opens the Surface List panel, revealing all frames in that
scan (see Figure 8.2., right). If the scan has only one frame, a panel with frame data will
appear in place of a list (see Figure 8.3.).

Highlighting specific frames will make them (and only them) appear in the 3D View win-
dow. When the Show other selected scans option at the bottom of the panel is checked,
the selected frames from other scans will also appear in the 3D View window. You can
select frames in a number of ways:

• Click LMB on the frame name to select it while clearing other selections.

• Click LMB while holding the Ctrl key to select several frames at once.

• Click LMB while holding the Shift key to select a sequence of frames in the
specified range.

• Click the icon in the Surface List panel to select all frames or to clear the selection.

• Use the dropdownmenu for to quickly select all key frames or all textured frames.

• Click Ctrl + A to select all frames.
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By using the or Ctrl + P shortcut you can start a sequential frame demonstration,
which you can then stop by pressing or hitting Ctrl + P again.

Figure 8.3.: Single-frame scan (model) representation.

8.1.2 Revising Scans

As you begin building a 3D model, you should start by preprocessing your scans: remove
unwanted frames, separate misaligned areas (if any) into separate scans and cut out un-
wanted objects from the scene.

You may, however, encounter the following problems:

Figure 8.4.: Possible scan errors.
Bad geometry on the left, scan misalignment in the middle and hands captured in frames on the

right.

• Misaligned frames (see Figure 8.4., left)—may occur because of small size, an insuf-
ficient number of geometrical features on the object or an insufficient number of
polygons in a frame.

• Misaligned parts (see Figure 8.4., middle)—occurs when the real-time alignment
algorithm incorrectly determines the position of the new frame relative to previous
ones.

• Unwanted objects in the frame (see Figure 8.4., right).

A visual inspection of the frames can be very helpful in determining problematic areas.
To perform a visual inspection, select the scan and view all the frames that it contains by
holding Up Arrow or Down Arrow on the keyboard. This technique can easily detect
misaligned frames.
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See also:

Misalignment Detection.

Removing Unwanted Frames

You must delete from your scans any misaligned frames as well as frames with an insuf-
ficient number of polygons. To do so, select the frames from the list and hit Delete
.

Note: The system will not ask you for confirmation before performing this operation; it
will delete data instantly once you hit Delete . You can restore deleted data by clicking
the (Undo) button.

Separating Scans

During the fine-alignment process, frames in certain scans may be misaligned. Some-
times it’s possible to divide the problematic scan into several scans, where each part is
registered fairly well. In this case, divide the scan. To move some of the frames into a
new scan, use the following procedure:

1. Select in the Surface List panel the frames you want to move (see Selecting Frames).

2. Click RMB and select Move to new scan (Figure 8.2., right).

You can also fix alignment errors in another way: reset the current frame-transformation
values and repeat the registration, making any appropriate changes to the settings. Select
the desired scan in theWorkspace panel, click on it using RMB and select Reset transforma-
tions from the dropdown menu. Doing so will reset the computed positions of individual
frames in the scan. A dialog will then appear, prompting you to confirm the operation.
To compute new positions, run the Rough serial registration and then Fine registration al-
gorithms (see Fine Registration).

8.1.3 Editing Scans

To edit selected scans, open the Editor tools from the side panel. The , , , ,

and icons will appear alongside the icon bar in the 3D View window. These but-
tons correspond respectively to the Positioning, Transformation, Smoothing brush, Eraser,
Defeature brush and Texture-healing brush tools.

Moving, Rotating and Scaling (Transformation Tool)

The Transformation tool allows you to move, rotate or scale objects in the 3D View window.
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Figure 8.5.: Editor panel.

To access this tool, open the Editor panel and select Transformation tool by either clicking

or hitting T . The panel will open, displaying three tabs that correspond to different
modes for altering the object position in the global coordinate system. The name of the
active mode appears at the bottom of the 3D View window.

To enter translation mode, click the Translate tab or hit T . Three input fields will appear
in the Editor panel showing the current origin coordinates (in millimeters) of the
local coordinate system. The initial position of the local coordinate system will be
in the center of the global one. To translate an object, do either of the following:

• Enter the new coordinate values for the local system using the input fields in
the Editor panel. To adjust the position only along a specific axis, first hit the
corresponding X , Y or Z key.

• Freely translate the object in the 3D View window by dragging the control
square. Or translate the object along a specific axis by dragging only the nec-
essary control arrow near the control square (see Figure 8.6.).

Note: Orienting the object may be easier if you first specify a new position for the
origin of the local coordinate system: double-click on the desired surface point in
the 3D View window.

Figure 8.6.: Translation control

To enter rotation mode, click the Rotate tab or hit R . Three input fields containing the
Euler-angle values will appear in the Editor panel. Initially, all values are set to
zero. To rotate the object, do either of the following:
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• Enter the new angle values (in degrees) using the input fields in the Editor
panel.

• Drag one of the three circles (see Figure 8.7.) to rotate the object. Hitting the
key that corresponds the required axis (X , Y or Z ) will hide the controls for
the other axes.

Note: Orienting the object may be easier if you first specify a new position for the
center of the local coordinate system: double-click on the desired surface point in
the 3D View window.

Figure 8.7.: Rotation control

To enter scaling mode, click the Scale tab or hit S . A single input field with the current
scale value (1.000) will appear in the Editor panel. You have two options for scaling
the object:

• Enter the new scale value in the field.

• Drag the origin of the control (Figure 8.8.) or either of its round ends in the 3D
View window.

Figure 8.8.: Scaling control

After altering the object using any of the methods described above, confirm or cancel your
changes by clicking Apply or Cancel, respectively. Each time you click Apply, Artec Studio
will save the object position in the project history. Therefore, you can revert to the initial
object position using the (Undo) button in the Workspace panel after you exit the Editor
panel.

Placing Objects on Coordinate Plane (Positioning Tool)

You may need to place the model on one of the coordinate planes (e.g., for aesthetic
reasons or when preparing the model for measurements, for capturing a screenshot, for
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exporting and so on). Instead of adjusting the model position using the Rotate and Trans-
late modes of the Transformation tool, you can use the special Positioning tool. To do so,
follow these steps below.

Tip: The Enable automatic base removal option may come in useful to position scans au-
tomatically after the scanning completes (see Base Removal: Erasing a Supporting Surface.)

Figure 8.9.: Positioning the model in the global coordinate system.

1. Open the Editor panel from the side toolbar and click either Positioning tool or the

button in the upper part of the 3D View window, or hit P .

2. Choose the coordinate plane in which you want to place the model by activating
one of the following options: XOY, YOZ or ZOX. Note that you may skip this step
and return to it after Step 3.

3. Use LMB to specify at least three points on the surface; the plane will automatically
pass through their center of mass (see Figure 8.9.). The following conditions will
then apply:

(a) For each additional point you specify, Artec Studio rebuilds the plane. Click
Clear points at any time to redefine the points.

Note: Three points determine a plane. When you’re dealing with
nonplanar surfaces, however, three points may be insufficient. In that
case, the more points you specify, the more precisely a plane will fit
the surface.

(b) In addition to the plane passing through the center of mass of the points you
select, the coordinate origin will shift to that location as well.

(c) The position of the coordinate origin is adjustable, as Step 5 describes.
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4. Invert the direction of the coordinate axis, if desired, by clicking the Invert Z button
for the XOY plane, Invert X for YOZ, or Invert Y for ZOX.

5. If appropriate, adjust the model’s position relative to the coordinate origin:

(a) Shift + LMB —rotate the model around the axis that is currently normal to
the plane

(b) Shift + RMB —move the model along the plane in a fixed direction

(c) Shift + LMB + RMB —move freely along the plane

6. Hit Apply to fix the model on a specified plane or Cancel if you are dissatisfied with
the position.

Smoothing Brush

The Smoothing brush is a tool that you can employ selectively in specific areas without
touching areas that require no alteration (for more information about automatic smooth-
ing, consult Smoothing).

To use the Smoothing brush,

1. Select just one surface

2. Open the Editor panel, and click the icon or hit S .

3. Hit Ctrl , an orange region will appear around the cursor in the 3D View window.

4. Change brush size if necessary:

• Use either the Ctrl + [ and Ctrl + ] shortcuts or

• Use Scroll wheel .

• Enter a size (in millimeters) in the Brush size field.

• Alternatively, you can adjust the slider bar in the Smoothing brush panel.

5. Set the smoothing strength if necessary:

• Enter the desired value in the Smoothing strength field or

• Adjust the slider bar.

6. Hold LMB and paint the surface region in order to smooth it. The tool will smooth
the affected areas (see Figure 8.11., right).

Once you’re done, click the Apply or Cancel button.

Erasing Portions of Scans

Nearly always, the scanning process will capture unwanted elements, such as walls, the
operator’s hands, surfaces on which the object is located and other extraneous objects.
This unwanted data can hinder postprocessing. To avoid this problem, we recommend
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Figure 8.10.: Smoothing brush panel.

Figure 8.11.: Before smoothing (left) and smoothing out a poorly captured area (right).

eliminating these objects before processing. We designed several options to quickly and
easily remove unwanted elements from the scene (see Figure 8.13.).

2D selection —is designed for deleting areas and elements of medium size.

3D selection —is useful for accurately cleaning small object areas.

Rectangular selection —allows you to select large rectangular regions.

Lasso selection —allows you to create a selection by freely outlining it with the cursor.

Cutoff-plane selection —is a special mode for removing flat surfaces (table, floor or base)
on which the object is resting. This mode uses a cutting plane that divides the scan
into two parts: the first will remain and the second will be erased (see Figure 8.16.).

Tip: The Enable automatic base removal option deletes the supporting surface automati-
cally after you close the Scan panel (see Base Removal: Erasing a Supporting Surface.)

Use the following general procedure to erase unwanted elements:

1. In theWorkspace panel, select the scan you want to edit and open the Editor panel by
clicking its icon in the side toolbar. Editor icons will appear alongside the existing
ones in the 3D View toolbar.

2. If the scan is rendered with no texture, make sure its color is neither red nor any
shade of red. Assigning non-red colors to the scan will help you easily identify the
polygons you have selected for erasure. If necessary, change the scan’s color by
clicking the colored square ( ) near its name.
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Figure 8.12.: Eraser panel.

Figure 8.13.: Various Eraser modes (from left to right): 2D, 3D, Rectangular, Lasso.

Figure 8.14.: Select through in 2D Eraser: enabled on left and disabled on right.
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3. Open the Eraser tool by clicking or by hitting E .

4. Select the desired erasure mode (consult the list above).

Note: If you intend to use Cutoff-plane selection, make sure the Select

through toggle is in the position in the 3D View window.

5. Mark the elements you want to erase. Hold down the Ctrl key and do any one of
following, depending on the active mode:

• 2D/3D selection—adjust the tool size (see Table 8.1.) and paint over the area
using LMB .

• Rectangular selection—drag the cursor to select a rectangular region.

• Lasso selection—drag the cursor to freely outline an irregular region.

• Cutoff-plane selection—adjust the tool size (see the table) and paint over the
flat area. Once you have released the mouse button, a plane will appear (see
Figure 8.16.). If necessary, adjust the plane level by using Scroll wheel
while holding down Ctrl+Shift .

6. Click Erase to eliminate the area highlighted in red or to apply cutting plane.

Table 8.1.: Basic actions in the Eraser mode.

Purpose Procedure
Deselect
region

Reselect the region while holding down Ctrl+Alt

Undo
operation

Hit Ctrl+Z or click

Adjust tool
size

Use ] and [ keys or Scroll wheel while holding down Ctrl

Protect
backface from
erasure

Use Select through toggle: —backface is protected (see Figure

8.14., right); mandatory for Cutoff-plane selection —backface is
affected (see Figure 8.14., left)

Reach
difficult-to-
access
regions

Select (in the same way as for erasure) occluding polygons and click
Hide

Hiding Polygons When Using Eraser Tool

If polygons obstruct the region you want to erase, you can hide them. Before doing Step
5 of the procedure under Erasing Portions of Scans, do the following:

1. Ensure the Select through toggle is in the position in the 3D View window.
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Figure 8.15.: Selecting a flat region in the Cutoff-plane selection mode.

Figure 8.16.: Cutting plane

Figure 8.17.: Erasing results
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2. Mark the obstructing region using the technique described in Step 5 of the procedure.

3. Click Hide to gain access to the obstructed region.

4. Mark the region you want to erase.

Defeature Brush

Erasing certain geometrical imperfections often demands further processing of the result-
ing holes in the model. The Defeature brush combines functions of the Eraser and Hole
filling tools and may boost your productivity. To use it, follow these steps:

Figure 8.18.: Defeature brush panel.

1. Select the surface in the Workspace panel. You can only choose one model or one
frame from the scan.

2. Open the Editor panel using the side toolbar and click either Defeature brush or the

button in the upper part of the 3D View window, or hit D .

3. In the Editor panel, choose the selection type: 2D selection or 3D selection. The
operating principle is the same as for the Eraser tool—that is, in 2Dmode all surfaces

throughout the model are affected (if toggle is enabled), while in 3D mode the
brush only works on the visible surface.

Note: For most surfaces, results obtained in 2D mode with toggle
disabled will be approximately the same as those in 3D mode.

4. Hit Ctrl to activate the tool. Depending on the selection type, a red circle or an
orange spot will appear in the 3D View window.

5. While still holding down Ctrl , adjust the spot size (see Figure 8.19., 4) or circle
diameter (see Figure 8.19., 3) using Scroll wheel or the [ and ] keys. Their
size should match the size of feature you want to remove.
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6. While still holding down Ctrl , press and hold LMB and paint over the area you
want to modify. A red stroke will appear. When you release LMB , the software will
delete the feature, close up the hole and smooth the surface.

7. If necessary, repeat Steps 3–6

8. Click Apply to implement all changes.

Note: If you are editing a textured model, don’t forget to enable the
Render polygons without texture option in the View menu (see Rendering
and Texturing Untextured Polygons) to display the processed surfaces. Note
that the texture will disappear, but you can restore it through texture
mapping (see Applying Texture).

Figure 8.19.: Defeature brush in action.
From left to right: real object without any imperfection (1), imperfection on the scanned surface

(2), 2D brush cursor (3), 3D brush cursor (4), results of applying the Defeature brush.

8.2 Fine Registration

Fine registration is an algorithm designed to automatically and precisely align captured
frames. It starts once you complete scanning and close the Scan panel 1.

Note: Since the Fine registration algorithm runs automatically and uses the settings in
the Tools panel, ensure that you have specified the proper (or, better, the default) values
before you start scanning.

In a number of cases you can start the Fine registration algorithmmanually using the Tools
panel. To access a list of parameters, click the button in the Fine registration section. The
algorithm affects all scans marked with the icon in the Workspace panel (see Selecting
Data for more information on scan selection), but it processes them separately.

From two to three parameters may be available. You can redefine either of them:

registration_algorithm is a type of registration algorithm

Texture_and_Geometry takes both texture and geometry into account. If
the scan lacks texture information, the algorithm will run on geome-
try only.

1 There is another post-scanning algorithm: automatic base removal (see Base Removal: Erasing a Sup-
porting Surface.)
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Geometry uses geometry only. Unless your scan entirely lacks texture,
we recommend avoiding this option.

refine_serial is enabled by default for Geometry mode and is available as an option for
Texture_and_Geometry mode. It represents the conventional fine serial-registration
algorithm and registers in-series captured frames.

loop_closure is an advanced algorithm that registers any frames not necessarily captured
in series. Using any common regions in these frames, it compensates for cumu-
lative error (see Figure 8.22.) caused by the peculiarities of handheld-3D-scanner
movements. We highly recommend enabling this algorithm when you’re using Tex-
ture_and_Geometry mode.

Figures below illustrate how each algorithm works if launched independently. The call-
out boxes in each figure show two frames from the same corner of the door: one captured
at the beginning and one at the end of the scanning session. The captured data (see Figure
8.20.) has a cumulative error that is noticeable in the call-out box. The serial registration
algorithm improves frames’ relative position (see Figure 8.21.), but misalignments remain.
The loop-closure algorithm eliminates these misalignment completely (see Figure 8.22.).

Figure 8.20.: Rough data as is

Figure 8.21.: Serial-registration results
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Figure 8.22.: Loop-closure results

8.3 Scan Alignment

Although Artec Studio features continuous scanning, there may be some cases where the
application lack sufficient information about the relative positions of multiple scans. To
assemble all scans into a single whole, you must convert the data to a single coordinate
system—that is, you must perform alignment using the Align tool.

Hint: If you find the coverage too long, you can refer to Auto-Alignment first. Take a
glance at the Summary of Alignment Modes as well.

8.3.1 Selecting Scans for Alignment

In the Workspace panel, use the flag to mark all scans that you intend to work with.
Once you click Align in the side panel; the marked scans will appear in the left panel in
the same order as they appear in the Workspace panel. During the Align operation, Artec
Studio divides the selected scans into two sets: aligned (registered) scans and unaligned
scans. The first set initially contains only one scan (the first one in the list), which is
highlighted in blue. Its name appears in bold and uses the same color icon ( ). Auto-
Alignment, however, may produce several groups of aligned scans.

The user’s task is to align all scans to those that are already registered and to “assemble
a model”. In general, the procedure includes the following steps:

1. Click the required tab in the Align panel.

2. Select one scan from the unregistered group in the Align panel. The name of un-
registered scan appears in a regular typeface. When selected, the unregistered scan
is marked by the green icon . You can select several scans using either of the
following methods:

• Press and hold down the Ctrl key, and then click each scan that you want to
select
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• Click the first item, press and hold down the Shift key, and then click the
last item.

3. If necessary, specify point pairs (for two scans) or sets of points (for more than two
scans) and click the desired alignment-command button (Auto-Alignment is the most
recommended one). The command affects all scans selected in the Align panel plus
the first one ( ).

Since each mode varies in its effects, see the details in the corresponding subsections
for more information. Note that you can use either one mode or a series of modes (see
comparison table in Summary of Alignment Modes): drag alignment, rigid alignment with
and without point specification, automatic rigid alignment, and alignment with surface
deformations.

Changing Scan Status

If you have already aligned several scans, you should move them to the registered group.
Select them in the Align panel using LMB . Next, click RMB on the name of any scan
and select the Mark as registered option from the dropdown menu, or just double-click
its name in the list. At this point, Artec Studio will treat registered scans as one, so you
cannot move them independently.

If you accidentallymark a scan as aligned, remove it from the registered group by selecting
the Mark as unregistered item from the dropdown menu, or just double-click it.

8.3.2 Displaying Scans in 3D View

Scans selected in the Align panel appear in the 3D View window. Keys 1 , 2 and 3 switch
among scans in the 3D View window:

1 shows aligned scans and groups

2 shows scans that are currently under alignment

3 shows all scans

Navigation in align mode is similar to navigation in the 3D View window:

Rotate hold LMB and move mouse

Zoom in/out use Scroll wheel , or hold RMB and move mouse

Move hold LMB and RMB simultaneously, or hold the middle button, and move mouse

8.3.3 Summary of Alignment Modes

The table below provides basic information on the various alignment modes (see Scan
Alignment).

• Scan type lists which scans you can use in a particular mode.

• Scans per operation is the number of scans required to use a particular mode.
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• Markers in set prescribes how many markers (points) you can map in one point set.
Some modes require point (marker) sets, but some don’t.

• “—” means that markers are unnecessary.

• “0 or 2”means point specification is optional and, if you do specify them, onlymarker
pairs are allowed.

• “At least 1” means you can specify an unlimited number of markers in one set.

Table 8.2.: Parameters for alignment modes.

Mode Scan Types Scans per
Operation

Markers
in Set

Notes

Rigid
(mark-
ers)

Any 2 2 Considers only coordinates,
not geometry

Rigid
(meshes)

Any 2 0 or 2 Considers geometric features

Rigid
(tex-
ture)

Multiframe with
poor geometry

2 0 or 2 High resource consumption

Rigid
(auto)

Any Any number — Works if surface is well
textured

“Drag” Any 2 — Interactive
Non-
rigid

Models Any number 0 or 2 Deforms surfaces and
textures; pre-alignment
required

Com-
plex

Any 1 (at least 2
for models)

At least
1

Precise and flexible

8.3.4 Drag Alignment

Drag alignment is always available, regardless of which tab is active in the Align panel.
This mode allows you to align scans by manually dragging them in the 3D View window.

Owing to the low accuracy of this approach, however, you can optionally use it for pre-
liminary alignment before running more-accurate modes.

1. Select the scan you want to align, keeping in mind the recommendation at the
beginning of Scan Alignment. Artec Studio allows you to select multiple scans, but
note that it will align them with the registered scans as a single unit.

2. Holding down the Shift key and one mouse button, move and rotate the scan
you’re aligning (a green one ) close to the registered scan (a blue one ). Scan
Alignment provides a list of allowed movements and corresponding buttons.

3. To confirm the alignment, release the mouse button(s) and the Shift key, then
click Apply. Note carefully that any scans you are registering won’t automatically
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Figure 8.23.: Dragging a scan

Figure 8.24.: “Drag” alignment result
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move to the registered set (see Figure 8.24.). You can do so manually as the
beginning of Scan Alignment describes.

4. If you have several scans to align, repeat these steps for each one individually.

8.3.5 Auto-Alignment

Rigid alignment is a universal mode suitable for aligning most scans. Auto-alignment is
the easiest approach, however. The advantages of this latter mode include the ability to
align several scans at once and avoid the need to specify points; the only disadvantage is
minimum requirements for the size of the overlapping areas in the scans you’re aligning.

To perform auto-alignment, follow these steps:

1. Make sure the Rigid tab is selected (see Figure 8.26.).

2. Select all the scans by using either Ctrl or Shift , as the Scan Alignment section
mentions.

3. Click Auto-alignment. Ideally, Artec Studio aligns all the scans and marks them using
the icon. It may, however, mark scans as registered even though the 3D surfaces
failed to join properly.

Important: Auto-alignment may be unsuccessful if the scans have small overlapping
area.

Auto-alignment may produce the following results:

• Aligned scans, marked with the icon (basic group of registered scans)

• Unregistered scans, marked with the icon

• One group ( ) or several groups ( , ) of registered scans. Scans forming this group
failed to align with the basic registered group ( ), although they succeeded in align-
ing with each other.

We recommend resolving issues with unregistered scans or registered groups by align-
ing them manually as Manual Rigid Alignment Using Point Specification describes. Other
methods may also help.

Managing Groups and Scans

You can perform the following actions on the scans from the list in the Align panel (right-
click on the item to open the context menu):

Mark as registered Only available for single unregistered scans ( → )

Mark as unregistered Use this command to discard the alignment state of a particular
scan (unavailable for scans)

Select group Highlights the respective group ( , , and so on)

8.3. Scan Alignment 97



Artec Studio, ver. 11

Mark group as registered Converts all scans from the group into the basic registered
group ( → )

8.3.6 Manual Rigid Alignment Without Specifying Points

You can perform rigid alignment either with or without specifying points. If the scans
are close to each other in distance (e.g., after “drag” alignment), or if they have a large
overlapping area or rich texture, you can skip the task of point specification when aligning
them.

Perform the following steps:

1. Make sure the Rigid tab is selected (see Figure 8.26.).

2. Select the scan you want to align, as the beginning of Scan Alignment describes.

3. Click Align. The result should be as Figure 8.28. depicts. If you are dissatisfied with
this result, click and follow the recommendations inManual Rigid Alignment Using
Point Specification.

4. Select another scan from the list of unregistered scans and repeat the above proce-
dure.

5. Click Apply to confirm your alignment results or Cancel to reject them.

Texture Alignment

If the object was scanned with texture, the texture-alignment feature may ease the align-
ment process. It uses texture-image characteristics of scanned objects and greatly de-
creases the possibility of incorrect alignment. This feature also helps to align objects
with few or no geometrical features, such as round or flat objects with no corners. If an
object has rich, nonrepetitive geometry, however, we recommend disabling texture align-
ment to reduce the algorithm’s running time. Also keep in mind that texture alignment
will be useless if the object texture is monochrome.

To enable texture alignment, select the Enable texture alignment checkbox at the bottom
of the Align panel just before you perform Step 3 of the procedure above.

Figure 8.25.: Checkbox for texture alignment.

Note: Texture alignment is a resource-intensive algorithm that slows down the align-
ment process. We recommend using it only in cases where the object’s geometrical fea-
tures are insufficient.
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8.3.7 Specifying Points and Editing Their Positions

Before considering how to align scans using points, it is helpful to highlight point-pair
specification. The alignment algorithm uses pairs of point, or point sets in “Complex
alignment” mode (Complex Alignment), to detect scan areas that should be brought close
together.

To do point alignment, create several point pairs. To create one pair, mark one point
on the aligned scan and then mark another one on the unaligned scan. Ensure that in
each case the points for a given pair match a corresponding point on the surface of a real
object; note, however, that high matching accuracy is unnecessary, since Artec Studio
only uses the pairs to gain a rough approximation before performing precise registration.
In the Complex mode, you can create a set of points (instead of just a pair), i.e. you can
simultaneously specify more than two points in one or several unregistered scans and
only one in the registered scan. All these points are connected by polylines and form a
set.

When specifying points in the Rigid and Nonrigid modes, the application automatically
creates pairs. Having specified one pair, you can immediately create the next one. In
Complex mode you must confirm set creation by hitting Space or by clicking New set
from the left panel, because the set may comprise multiple points (see Figure 8.27. and
Figure 8.33.).

You can toggle between the point pairs (sets) by hitting Space and Backspace , or by
clicking RMB in the 3D View window and selecting the relevant options from the menu.
You can also relocate points in the pair (set). Hover the mouse cursor over the point until
the pair (set) is highlighted in white, then drag the point to the proper position using LMB
, or select the pair (set) and specify a new position using LMB . To confirm your actions
and deselect the pair (set), hit Space . You can also remove either a pair (set) or one of
its individual points: click on the point using RMB and choose the appropriate command
from the menu. Alternatively, you can use Del to remove the selected pair (set).

8.3.8 Manual Rigid Alignment Using Point Specification

We advise using this mode when scans are located at a significant distance from each
other.

To use this approach, follow these steps:

1. Make sure the Rigid tab is selected (see Figure 8.26.).

2. Select the scan you want to align, as the beginning of Scan Alignment describes.

3. Specify several point pairs (Figure 8.27.), keeping in mind the recommendations
from Specifying Points and Editing Their Positions.

4. Click Align markers. This mode takes into account only the coordinates of specified
points and tries to reduce the distance between the markers for each pair.

5. Carry out Steps 3–5 of the procedure in Manual Rigid Alignment Without Specifying
Points.
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Figure 8.26.: Align panel: Rigid tab.

Figure 8.27.: Creation of point pair.
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Figure 8.28.: Alignment result.

8.3.9 Nonrigid Alignment

Whereas rigid alignment can only perform such transformations as translation and rota-
tion, the nonrigid algorithm can deform 3D data. This algorithm is intended to process
so-called nonrigid objects: objects whose shapes have changed during the scan (e.g.,
models of animals or humans—see Figure 8.30., left). Keep in mind that the surface Artec
Studio produces as a result of the deformation may differ from the surface of the actual
object.

Note: Nonrigid alignment works on models only. Thus, before you run it, prepare models
by fusing the source scans. It is also necessary to first align models in rigid mode (see
Manual Rigid Alignment Without Specifying Points, Auto-Alignment or Manual Rigid Align-
ment Using Point Specification).

To run the nonrigid alignment, follow these steps:

1. Make sure the Nonrigid tab is selected (see Figure 8.29.).

2. Select the models you want to align, as the beginning of Scan Alignment describes.

3. If themodels differ significantly from each other, we suggest that you specify several
point pairs, keeping in mind the recommendations in Specifying Points and Editing
Their Positions.

4. Where necessary, adjust the deformation degree using the flexibility slider. The
greater the flexibility value (i.e., the more “flexible” the deformation), the longer
the computation will take.
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Figure 8.29.: Align panel: Nonrigid tab.

Figure 8.30.: Two models after rigid (left) and nonrigid alignment (right).
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Warning: Avoid extreme Flexibility values. Applying very large values
may result in major surface distortions and may slow down the algo-
rithm. Extremely low values, on the other hand, barely deform surface
and often fail to produce the expected nonrigid-alignment results.

5. Click Align.... The algorithm will align models by deforming one of the model (see
Figure 8.30., right). If you are dissatisfied with the alignment results, click and
specify additional point pairs, or reposition the current pairs.

6. Select another model from the unregistered set and repeat the steps above.

7. Click Apply to confirm your alignment results or Cancel to reject them.

Figure 8.31.: Flexibility slider in action: original model (left), nonrigidly aligned model
with low Flexibility value (middle) and with high value (right).

Note: This version of Artec Studio does not support texture mapping on nonrigidly
aligned models.

8.3.10 Complex Alignment

Complex alignment allows you to align not only scan to scan, but surface to surface within
a given scan (see the mode comparison in Summary of Alignment Modes). Relative to other
modes, this one supports multipoint-set definition—that is, you can link more than two
points. It’s useful for aligning scans obtained during circular movements of the 3D scanner
in cases where fine registration with the loop_closure option enabled fails to align them.
To run the Complex alignment, perform the following steps:

1. Make sure the Complex tab is selected (see Figure 8.32.).

2. Select the scans you want to align, as the beginning of Scan Alignment describes.
This mode allows you to work even with just one registered ( ) scan.

3. Specify one or more point sets on the scan surface (see Figure 8.33.), keeping in
mind the recommendations in Specifying Points and Editing Their Positions.

4. Click Align... to run the alignment with your specified constraints (Figure 8.34. shows
example results). If you are dissatisfied with the alignment results, click and
specify additional point sets, or reposition the current sets. To redo an operation

that you have undone, click .
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Figure 8.32.: Align panel: Complex tab.

Figure 8.33.: Before alignment: two point-set added.
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Figure 8.34.: Alignment result.

5. Click Apply to confirm your alignment results or Cancel to reject them.

8.4 Global Registration

Once you have aligned all your scans, proceed to the next stage: global registration.
The global-registration algorithm converts all one-frame surfaces to a single coordinate
system using information on the mutual position of each surface pair. To do so, it selects
a set of special geometry points on each frame, followed by a search for pair matches
between points on different frames. To perform correctly, the algorithm requires an initial
approximation, which a user ensures in the course of the Align operation.

Note: Global registration is a resource-intensive operation. Processing of large data sets
may take a long time and require a large amount of RAM.

To launch the algorithm, select all aligned scans in the Workspace panel. Next, open the
Tools panel and locate the Global registration section. Click Apply.

8.4.1 Global-Registration Parameters

registration_algorithm the type of algorithm that will perform scan registration. If an
object has rich texture and poor geometry, consider using the Texture_and_Geometry
option. For objects with rich geometry, you can choose Geometry mode to increase
the registration speed.
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minimal_distance the minimum distance between adjoining feature points on the object
(in millimeters).

iterations the number of iterations of the global optimization algorithm. Optimization is
a part of the global-registration algorithm.

8.4.2 Possible Global-Registration Errors

• After the global-registration algorithm finishes, the frames are in disarray (see Fig-
ure 8.35., left) or the frame positions are unchanged. This error occurs because the
application is configured for a different scanner type than the one that captured the
data. Change the device type in the application settings (see Algorithm Settings).

• The algorithm has completed successfully, but a gap exists between two or more
scans (see Figure 8.35., right). Select just these scans in theWorkspace panel and run
the global-registration algorithm. If the scans have drawn closer to each other but
have failed to align after the algorithm finishes, increase the number of iterations
and rerun the algorithm. Repeat this process until you achieve full alignment, then
run global registration once again for all data. If you are unable to align several
problematic scans, try aligning just two of them, then gradually increase the number
of scans until all of them are aligned.

Figure 8.35.: Global-registration errors: wrong settings on left and gap between scans on
right.

8.5 Outlier Removal

During the scanning process, so-called outliers may appear in the scene. Outliers are
small surfaces unconnected to the main surfaces. They require removal because they
may spoil the model or produce unwanted fragments. Artec Studio provides two ways to
remove outliers: erase them before fusion (preventive approach) or after fusion (“further-
ing” approach—see Small-Object Filter). We advise using the former approach because it
decreases the possibility of improper fusion by preventing noisy features from attaching
to the main surface.

This outlier-removal approach is based on a statistical algorithm that calculates for every
surface point the mean distances between that point and a certain number of neighbor-
ing points, as well as the standard deviation of these distances. All points whose mean
distances are greater than an interval defined by the global-distances mean and standard
deviation are then classified as outliers and removed from the scene.
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For better results, we recommend running global registration before starting the algo-
rithm. If you begin Outlier removal before doing so, a dialog will appear prompting you to
perform global registration.

Figure 8.36.: Outlier removal: before and after.

In most cases, none of the parameters accessible through the button requires adjust-
ment. But if necessary, you can change the values of these parameters:

std_dev_mul_threshold a standard-deviation multiplier. We recommend choosing the
value for this parameter according to the following guidelines:

2 for noisier surfaces

3 for less noisy surfaces

resolution should be set equal to the resolution of the Fusion process that you expect to
run later.

Click Apply to run Outlier removal.

8.6 Fusion

Fusion is a process that creates a polygonal 3D model. It effectively melts and solidifies
the captured and processed frames. Fusion is the most interesting part of the processing
task because a polygonal 3D model is what most people expect to see when performing
a 3D scan. To this end, you can use one of the following algorithms, each of which has a
self-explanatory name (see also the summary in Table 8.3.):

• Fast fusion produces quick results.

• Smooth fusion is good for scanning the human body because of its ability to com-
pensate for slight movements by the person you’re scanning.

• Sharp fusion perfectly reconstructs fine features and is suited to both industrial ob-
jects and human bodies. It is the onlymode that allows you to use all the capabilities
of a Artec Spider scanner.
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Figure 8.37.: Models of a human subject obtained using various algorithms: Fast fusion
(left), Smooth fusion (middle) and Sharp fusion (right).

Figure 8.38.: Models of a shoe sole obtained using various algorithms: Fast fusion (left),
Smooth fusion (middle) and Sharp fusion (right).

Table 8.3.: Comparison of fusion modes.

Fast Fusion Smooth Fusion Sharp Fusion

Usage
Fast results for large
data sets; also for
measurements

Large, noisy data sets
with patchymissing re-
gions; scans of moving
objects

Scans from Artec Spi-
der; scans having re-
gions with fine details
and sharp edges

EVA resolution no less than 0.4
Spider resolution no less than 0.1
L resolution no less than 1.5
Fill_holes Not applicable Available

Features

Resulting surfaces are
relatively noisy. Of-
fers an additional pa-
rameter, radius

Smoother results. Can
compensate for slight
movements, but not
recommended for ac-
curate measurements.
Relatively slow.

Higher level of detail.
Faster than Smooth fu-
sion, but may intensify
existing noise.

To obtain a model:

• Make sure the scans you intend to fuse have passed Global registration.

• Select the scans in the Workspace panel using .

• Enter the Tools panel.

• Select the necessary mode; optionally, specify parameter values.

• Click Apply.
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• View the model in the 3D View window and in the Workspace panel once the algo-
rithm finishes. The model name will match the algorithm name.

The fusion algorithms use the following parameters:

resolution —the step of the grid (in millimeters) that the algorithm uses to reconstruct a
polygonal model. In other words, this parameter defines themean distance between
two points in a model. The lower the resolution value, the sharper the shape. When
specifying values, keep in mind the default values and lower limits in Table 8.3..

radius —only for Fast fusion, a multiplier or integer factor that defines the surrounding
space that the algorithm takes into consideration when adding each new minimum
spatial unit. Note that the size of the spatial unit remains unchanged and is equal to
the resolution value; the actual search radius is the product of resolution and radius.

Fill_holes —instructs the algorithm to fill holes in the mesh being reconstructed; option
unavailable for Fast fusion. The methods for filling the holes are as follows:

By_radius —fills all holes with radius less than or equal to the specified
value in the max_hole_radius text box (in millimeters)

Watertight —automatically fills all holes in the mesh

Manually —prompts you to fill holes manually in the Edges panel, which
opens automatically

remove_targets —allows you to erase small embossments from surfaces on which targets
are placed (see Target-Assisted Scanning). Parameter can assume either the On or
Off value; unavailable for Fast fusion.

8.6.1 Fusion-Algorithm Errors

Occasionally, defects appear in the 3D model after fusion; some are correctable by creat-
ing additional scans, whereas others are correctable by using the model-processing tools
described in the next section.

Figure 8.39.: Surface noise caused by insufficient data (left) and improved model after
adding one more scan (right).

Errors that can be corrected by capturing additional scans include low-amplitude noise on
the surface (see Figure 8.39., left). Normally, this error indicates that the affected area has
a small number of frames. The number of frames needed to eliminate the noise depends
on the reflective properties of the object’s surface. To correct the error, you need one
more scan to cover the noisy area (see Figure 8.39., right).
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Sometimes the cause of noise is an insufficient number of scanning angles. Areas captured
at a larger angle have more noise than areas captured at a direct angle (i.e., 90 degrees).
You can correct this error by scanning the area again using a better angle.

When the scanning conditions or the object features are such that you are unable to cap-
ture additional data, you can correct errors using the Edges (see Filling Holes and Smooth-
ing Edges) or Smoothing (Smoothing) tools. If such errors are frequent, reduce the speed
at which you move the scanner around the object, or increase the capture rate (see De-
creasing Scanning Speed).

8.7 Editing Models

The resulting fusion model may contain surface defects due to scanning or registration
errors. Artec Studio provides a number of tools to correct such errors:

Repair —corrects the model’s triangulation errors

Small-object filter —removes small objects located near the model surface

Edges —semiautomatically fills holes and smooths the model edges

Hole filling —fills holes in the model automatically

Smoothing —filters low-amplitude noise over the whole model

Smoothing brush —enables manual smoothing of the surface areas with the most noise

Mesh simplification —reduces the number of polygons in a model while minimizing lost
accuracy

Remesh —creates isotropic mesh while keeping the processed mesh as close to the orig-
inal as possible

Each algorithm processes all scans selected in theWorkspace panel and replaces the orig-
inal data with the results. If the algorithm is unsuccessful, you can restore the original
data by clicking (Undo) in the Workspace panel.

8.7.1 Correcting Triangulation Errors

Some algorithms may introduce triangulation errors into the resulting model. These er-
rors include the following:

Unattached vertices —points that are not vertices of any of the triangles

Vertices with identical coordinates —vertices that have the same coordinates

Faces containing invalid vertices —triangles that point to nonexistent vertices

Singular faces —triangles for which at least two of the three vertices coincide.

Faces with equal signature —faces with fully coinciding sets of vertices

Edges incident to three or more faces —edges that are adjacent to three or more faces
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Faces with wrong orientation —faces whose normals point in a direction opposite to
those of the adjoining faces

To correct these errors, mark a model in the Workspace panel by using the flag and hit
Ctrl + R or select the Window→ Repair menu command. If the algorithm detects no
triangulation errors, Artec Studio will notify you that it has found no defects. Otherwise,
the Repair panel will open, displaying the above-mentioned list of defects to be corrected.
Next to the names of the defects, a column will appear stating the number of defects of
a certain type found in the model. You can select all defects by pressing View all. Doing
so will display in the model all the defective vertices and triangles using colored points.
You can disable display of any particular defect type by removing the icon next to the
corresponding name, or disable them all by clicking View none. To correct the defects,
click Repair all. Clicking the Apply button accepts the changes.

8.7.2 Small-Object Filter

If you forgot to erase outliers before fusion (see Outlier Removal), Artec Studio may solidify
and preserve them in the scene as small, distant fragments.

You can effectively remove these remaining outliers by using a filtering algorithm.

To remove these artifacts, select in the Workspace panel only the model you are currently
editing, then open the Tools panel. Click Apply next to Small-object filter to run the algo-
rithm (see Figure 8.40.). A window containing algorithm settings will appear when you
click . You can adjust the following parameters:

mode —the Leave_biggest_objects option from the dropdown menu instructs the algo-
rithm to erase all objects except the one with the most polygons; Filter_by_threshold
erases from the scene all objects whose number of polygons is less than the amount
specified in the threshold parameter.

threshold —the maximum number of polygons for Filter_by_threshold.

Figure 8.40.: Filtering of scene outliers: before (left) and after (right).

8.7.3 Filling Holes and Smoothing Edges

Sometimes the shape of an object or the scanning conditions prevent you from properly
capturing of all parts of the scene. As a result, the fused 3D model will have holes. In
such instances, you can use the hole-filling tool to interpolate the surface.
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To start analyzing and correcting the model,

1. Select the model and click Edges from the side panel. The new panel has two tabs:
Edges and Holes, each of which contains a list of holes detected on the surface.
These defects are sorted by their perimeter length.

2. Select a hole, Artec Studio will highlight the corresponding edge in the 3D View
window.

Note: If the Move camera to selection option is checked, the model will
automatically rotate to display the selected edge. By default, the cam-
era moves smoothly from one edge to another when switching between
edges. If the model is large, however, this movement may take too long.
To expedite the switch, clear the Animate camera checkbox.

To select edges for correction,

• Mark the checkbox next to each one you wish to correct. These edges will be high-
lighted in red in the 3D View window (see Figure 8.41.).

• Use the Select all and Deselect all buttons in the panel to select or clear all selections,
respectively.

• You can also select edges right on the model. To do so, rotate the model to make
the edge visible in the 3D View window. Then click LMB to select it.

Figure 8.41.: Two holes marked for correction.

Under the Holes Tab, you can enable an option that automatically smooths the holes after
filling them by checking the Smooth holes after filling box (see also Smoothing). Under the
Edges Tab, use the Strength slider to control the edge-smoothing intensity. Also, you can
use this tab to smooth part of the edge instead of the whole one. To do so, rotate the
model to make the edge visible and mark it in the list as “processing required.” Next, hold
down LMB and move the mouse over the edge to drag apart the ends of the profile to the
desired position (see Figure 8.43.).

After you have selected all the edges or the holes you want to fix, click Fill holes or Smooth
edges. Artec Studio will repair the model. If the results are satisfactory, click Apply to
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Figure 8.42.: Result from running the Fill holes algorithm.

Figure 8.43.: Boundary selection for edge smoothing

Figure 8.44.: Edge-smoothing algorithm results.
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confirm them; otherwise, you can always use the button to cancel any changes. If
you try to exit the Edges mode without accepting changes, the software will ask you for
confirmation.

8.7.4 Automatic Hole Filling

To quickly and automatically fill holes, use the Hole filling algorithm in the Tools panel. It
employs the same edges as the Edges tool, processing only those holes with parameters
that correspond to the one user-adjustable setting, which you can access through the
button:

Figure 8.45.: Hole-filling algorithm: original model on left, processed on right.

max_hole_len maximum length of the hole perimeter in millimeters. The algorithm only
processes holes with perimeters below this threshold.

8.7.5 Smoothing

The smoothing algorithm evens out noisy areas in the 3D model. Artec Studio provides
two such tools: automatic smoothing of the entire model and manual smoothing of spe-
cific areas identified using a brush (see Smoothing Brush).

To run the automatic smoothing algorithm, open the Tools panel and select Smoothing.
You need only set one parameter:

steps —the number of algorithm iterations to be performed

8.7.6 Mesh Simplification

The mesh produced after fusion may be less than optimal for some applications because
it will contain a large number of polygons. This complexity will increase the amount of
memory the model occupies, hindering further processing. To optimize the model size
while retaining accuracy, use the Mesh simplification algorithm.

Select the model and open the Tools panel. You can choose from two algorithms.

Conventional Algorithm

Open the dropdown algorithm settings by clicking the button next toMesh simplification.
Select the appropriate processing method (determined by the stop_condition):

114 Chapter 8. Data Processing



Artec Studio, ver. 11

Figure 8.46.: Mesh simplification: original mesh on the left, optimized mesh on the right.

Accuracy —optimize model to a predetermined accuracy: the error parameter defines the
optimized model’s maximum allowable deviation (in millimeters) from the original
model. When the algorithm reaches this value, the optimization stops.

Remesh —perform simple mesh optimization, removing triangles whose edge lengths are
less than the remesh_edge_thr value (in millimeters).

Triangle_quantity —simplify the model by targeting the number of triangles specified in
the tri_num parameter. The algorithm minimizes the resulting model’s deviation
from the original model, but the final deviation value will remain unknown until
processing concludes. Use this method when you know how many triangles the
resulting model should have.

Note: To determine the number of triangles, double-click the appropriate
model from the list in the Workspace panel (see Figure 8.3.).

UV_Triangle_quantity —similar to the Triangle_quantity algorithm, but intended for
meshes with textures mapped by the Atlas method (see Applying Texture). This ap-
proach not only simplifies the polygon grid, reducing the number of triangles, but
it preserves texture.

UV_Vertex_quantity —simplify a texturedmodel by targeting the number of vertices spec-
ified in the vrt_num parameter.

The three first algorithms in the list above have additional parameters:

keep_boundary —maintain the model boundary. Mesh simplification on the scan edges
may affect their geometry. Thus, if the shape of the boundaries is more important
than the optimized mesh, select the On value. Otherwise, select Off, and the algo-
rithm will simplify the boundary mesh.

max_neighb_normals_angle —the angle between the normals of two neighboring faces.
You can specify an angle (default value is 120°) to prevent Artec Studio from creating
degenerate triangles. If the angle measure in some region exceeds the specified
value, the algorithm will leave the mesh unchanged in that region. Note that the
default value is appropriate in most circumstances.
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Figure 8.47.: Boundary-appearance options: keep_boundary enabled (left) and disabled
(right).

After adjusting the algorithm settings, click Apply to start processing.

Note: Mesh simplification may take a long time when the parameters of the original
and optimized models are significantly different (for example, if the deviation value is
high in Accuracy mode or if the required number of polygons in Triangle_quantity mode
is much smaller than the number in the original model). For very large 3D models the
operation requires extensive memory resources and may fail owing to insufficient RAM.
Free thememory by closing unused applications and by optimizingmemory usage in Artec
Studio, keeping inmind the recommendations inMemory, Command History and Selectively
Loading Project Data.

Fast Mesh Simplification

The Fast mesh simplification algorithm works faster than the conventional one. To run it,
perform these steps:

1. Open the dropdown algorithm settings by clicking the button next to Fast mesh
simplification.

2. Specify in the tri_num text box the desired number of triangles for the resulting
model. You can determine how many are in the actual model by double-clicking it
in the Workspace window.

3. Set the force_constraints option:

• If this option is set to Off, the value specified in the tri_num text box remains
constant.

• If this option is set to On and the algorithm is unable to produce a surface
with the specified number of triangles (tri_num), Artec Studio will automatically
update this value. In other words, improving the quality of the resulting surface
is the primary objective.

4. Click Apply to run the algorithm.

8.8 Automatic Processing

See also:

Autopilot
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Automatic processing is a special mode for the Tools panel that saves time and simplifies
postprocessing. It allows you to run all postprocessing algorithms from the Tools panel
(Rough, Fine and Global registration; Fast, Smooth and Sharp fusion; Small-object filter or
Outlier removal; Hole filling; Mesh simplification; Remesh; and Smoothing) with a click of
just one button.

Figure 8.48.: The extended Auto postprocessing menu.

To switch from manual to automatic mode, open the Tools panel and choose the Auto
option from the dropdown list in the left corner. Click the button near Go! to view all
options available in automatic mode. Note that only Global registration, Fast fusion and
Small-object filter are enabled by default. To perform other actions automatically, choose
the On option in the dropdown list next to the required function, or choose Off to exclude
a function from automatic processing. Click Go! or hit Ctrl + G to begin automatic
processing.

Each algorithm setting and parameter is based on the values for manual mode. To change
these values, switch to Manual mode, make the necessary alterations and then run auto-
matic processing—Artec Studio will apply all changes.

Keep in mind that the algorithms run in the order in which they are listed, starting with
Rough serial registration and ending with Remesh. Thus, if you want to run the Small-object
filter before Fast fusion or Global registration, for instance, you must do so manually.

Unlike manual processing, automatic processing runs without the need for constant user
attention, so it is more convenient when processing large objects: you can configure the
settings, start the process and leave it unattended. It can also process objects of any size,
reducing the number of mouse clicks to get the result.

8.9 Texturing

Artec scanners are equipped with a color camera, allowing you to capture 3D surfaces
with texture and expanding the range of objects available for scanning. Texturing is a
process that projects textures from the individual frames onto the fused mesh.
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8.9.1 Preliminary Steps

To take advantage of texture, do the following:

1. Make sure the Don’t record texture checkbox is cleared.

2. Adjust the capture frequency for texture frames (see Texture-Recording Mode) if nec-
essary.

3. Avoid turning off the flash bulb.

4. Adjust the texture brightness in Preview mode by using the eponymous slider in the
Scan panel.

5. Scan the object using a tracking algorithm of your choice. Captured frames are
marked with the letter “T” in the Workspace panel (surface-view mode) (see Figure
8.2., right).

6. Process the data and create a model, consulting the list in the beginning of Data
Processing or Autopilot.

7. Run a mesh-simplification algorithm for the resulting model (see Mesh Simplifica-
tion) to accelerate the texturing process.

8. Use the Texture panel to apply the texture to the model.

8.9.2 Applying Texture

The 3D model obtained after fusion contains no texture information. To apply textures
onto a model, open the Texture panel and choose a model from the first list (see Figure
8.50.); Artec Studio will apply the textures to this model. Next, select from the second list
the scans from which you created the model (these scans have the required textures).

Figure 8.49.: Simplified illustration of texture applying: texture as a single file.

Warning: We recommend that you avoid applying texture to models that have under-
gone major changes in geometry or orientation. The algorithm will apply the texture
incorrectly if you have done any of the following:

• Transform or position the model relative to its source scans

• Nonrigid alignment (see Nonrigid Alignment)
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Figure 8.50.: Choosing a texture-application method and adjusting its parameters.

• Erase major parts of the model

Perform these operations only after texturing.

Next, you will need to choose a method for applying textures to the model. Artec Studio
offers two methods:

• Generate triangle map

• Generate texture atlas

Generating Triangle Map

The Generate triangle map method transfers all textured triangles to a square texture im-
age (or a series of images). You can adjust the size of the triangles 2 (in pixels) using the
Triangle size slider (see Figure 8.51., right). To select the resulting texture size, use the
dropdown list (maximum texture size depends on the capabilities of your graphics card).
After changing the triangle/texture size, the estimated number of textures will appear
in the Estimated area at the bottom of the panel; the actual number may differ slightly,
however.

Generating Texture Atlas

The Generate texture atlas method cuts the surface into pieces, then unfolds and nests
these pieces flat and fits them into the specified image size (see Figure 8.51. (middle) and
Figure 6.12. in Displaying Boundaries of Texture Atlas). This method takes longer to run
than Generate triangle map, but the resulting texture is much more convenient for manual
editing.

2 Triangle size is determined by the number of pixels per side.
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Figure 8.51.: Texture mapping methods: mesh with texture applied (left), texture-atlas
sample (middle) and triangle-map sample (right). The latter covers only a portion of the
mesh surface (the rest two images not shown).

To modify a texture using an inpainting technique, use one of these two options:

Inpaint missing texture —allows you to apply a texture to regions with no texture infor-
mation by spreading it from the neighboring regions.

Remove targets —does the same thing, painting out targets by applying surrounding tex-
ture information (targets are used to facilitate scanning—see Target-Assisted Scan-
ning). This option makes sense if you enabled remove_targets before producing this
fusion model (see Fusion).

Enable texture normalization —this option is selected by default. It aims to compensate
for uneven lighting caused by movement of a scanner’s flash unit during capture.
We recommend leaving this option enabled.

General Information

Finally, select the required Output texture size and click Apply to start the texture-mapping
process.

Important: Texturing with the 16K resolution is only available if your graphics card
features at least 3 GB of GPU memory.

To reduce or increase the resolution (Output texture size) of the already applied texture,
you can re-apply it several times faster by enabling the Use existing atlas UV option.

Table 8.4.: Comparison of the texture-applying methods.

Mode Texture Distortion SpeedNumber of
Textures

Texture-Resolution
Management

Trian-
gle
map

Does not preserve
aspect ratio of triangles

Fast One or
more

Adjust triangle size and
texture-image resolution

Tex-
ture
atlas

Preserves aspect ratio
of triangles

Slow Only one Adjust texture-image
resolution

Note that to optimize resource utilization Artec Studio unloads all surfaces from memory,
except those needed for texturing, before running the applying procedure. For a more
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detailed description of selective project-data loading, see Selectively Loading Project Data.

8.9.3 Texture Adjustment

After the texturing is complete, you can adjust the texture on the model (see Figure 8.53.).

Note: You can always return to texture adjustment using the Adjust texture command in
the Workspace panel’s context menu.

Figure 8.52.: Hue, saturation and brightness representation.

You can adjust the following texture parameters by way of the corresponding sliders (see
Figure 8.52. for details):

• Brightness

• Saturation

• Hue

• Contrast

• Gamma correction

Figure 8.53.: Texture adjustments.

The initial position of the Hue slider corresponds to the current texture color. Dragging it
left or right corresponds to rotation counterclockwise or clockwise, respectively, on the
color wheel.

After making the necessary changes, click Apply to transfer the resulting textured model
to the Workspace panel.
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8.10 Texture-Healing Brush: Manual Inpainting

You can manually inpaint missing textures by using the Texture-healing brush. This tool
is based on the same algorithm as the Inpaint missing texture option covered in Applying
Texture. The inpainting algorithm uses texture information from neighboring regions to
fill in areas with missing or incorrect texture. Left image in Figure 8.54. shows a small
texture imperfection: a felt-tip pen mark on the figurine. Results of inpainting this region
appear in Figure 8.54. (right).

Important: This version of Artec Studio does not support texture restoration on the
models textured using Triangle map method and in regions of any models that have been
corrected using the Defeature brush.

Figure 8.54.: Texture-healing brush: before application (left) and after (right).

To launch the tool and inpaint a texture, do the following:

1. Make sure the model that you intend to edit is marked with the icon.

2. Open the Editor panel by clicking its icon in the side toolbar.

3. Select the Texture-healing brush by clicking the icon.

Note: Make sure the Select through toggle appears as in the 3D View
window.

4. Select a mode: 2D selection or 3D selection.

5. Hold down Ctrl while using Scroll wheel or [ and ] keys to adjust the tool
size. It should not exceed the size of the region that needs texture correction.

6. Paint over the region of interest using LMB while holding down Ctrl so that the
tool (a circle or a spot) only rolls over the problem area. Try to avoid touching
neighboring areas.

7. Click Apply to accept the changes or Cancel to reject them.

Note: If you paint an area in which the number of polygons exceeds the value specified in
the settings dialog (see Warnings), a message will appear prompting you to either ignore
the value, which means that processing may take longer, or cancel the operation.
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Additional Modes

This chapter describes other Artec Studio modes, such as

• Publishing to Viewshape (see Publishing to the Web)

• Multicapturing (Multicapturing)

• Measurement tools (Measurement Tools)

9.1 Publishing to the Web

Having models on a web may simplify the process of collaboration among users. Artec
Studio allows you to publish your 3D models on the Web through viewshape.com. View-
shape is a service that uses WebGL to render 3D models in a web browser. You can see
published models at viewshape.com or embedded at other websites, blogs or social net-
works. Models can be shared privately so that only those who know the unique URL can
see, comment on and use them.

Most browsers currently support WebGL. If this feature is disabled or unsupported in a par-
ticular browser, viewshape.com displays the 3D geometry as a pre-rendered set of images
that you can rotate using a mouse. Such images are called spin images.

To publish a model, use the Publish panel. It will open only if you have exactly one fusion
selected in the Workspace window; otherwise, Artec Studio will display an error message.
To log into viewshape.com, use yourmy.artec3d account. If the process fails, you can access
the login window from the link at the top of the panel (see Figure 9.1.).

After you successfully login, you will see the window shown in Figure 9.2.. Follow the
steps below to continue uploading:

1. Adjust model’s position in the 3D View window to see how it will appear on the Web.

2. Preview rotation when necessary.

3. Select visibility options (Public or Private).

4. Choose whether to employ WebGL: use Show to display a full-featured 3D model
and rotate it freely, or use Don’t show (spin image only) to display images of the
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Figure 9.1.: Viewshape.com login window.

Figure 9.2.: Publish panel.
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model captured from different angles. You can rotate these images only around the
vertical axis.

5. Select a license type for your model.

6. Specify the collection in your gallery to which you want to publish the model, or
create a new one.

In addition to the above steps, you must also set the Model name and, optionally, the
Model description. Once you have completed this entire process, click Publish; your model
will appear on the site.

9.1.1 Model Requirements

WebGL is a progressive API, but it is not very powerful. If your model contains several mil-
lion polygons and several very high-resolution textures, you will have difficulty rendering
it in a browser. Therefore, to produce a model that looks good, you must first optimize it.
We recommend the following model parameters:

• Fewer than 300 000 polygons

• Texture size of 1024x1024 pixels (512x512 is better)

• Texture mapped using Atlas method (mandatory)

• Model positioned appropriately to rotate around Y axis

Using LMB in the 3D View, you can rotate the model around its center of mass. Because
translation is impossible here, you should rotate the model to the position in which you
want it to appear on the web.

If the model parameters fail to satisfy the requirements and recommendations listed
above, a yellow notification will appear at the bottom of the window, along with a button
that instructs Artec Studio to fix the issue.

9.1.2 Fixing Issues

If your model suffers from one or more issues (as Figure 9.2. shows), click the Fix issues
button. The software will open the new panel shown in Figure 9.3..

Artec Studio can currently identify two issues: very dense meshes and incorrect texture
mapping. If the mesh is too dense, you must first simplify the model. The simplification
tool is available in the Issues found dialog. If the texture is mapped using the Generate
triangle map method, you can remap it by clicking Fix texture, as Figure 9.3. shows. The
Texture panel will then open, allowing you to fix it using the Generate texture atlasmethod
and the recommended resolution.

Once you have resolved all the issues, click Back to Publish to return to the Publish panel
and resume the publication process.
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Figure 9.3.: Fixing model issues.

9.2 Multicapturing

Artec Studio enables synchronized scanning with multiple scanners. This mode is helpful
when capturing a large object from several angles using more than one scanner simulta-
neously. Multicapturing with several scanners implies that the system knows their posi-
tion in advance. This condition simplifies and accelerates data processing considerably.
For this reason you must calibrate the relative positions of the scanners before capturing.
The resulting calibration data, which includes scanner IDs and their spatial orientations,
is referred to as a bundle.

You can bundle Artec 3D scanners, third-party 3D sensors or any combination thereof.
The only restriction is that the bundle should include no more than one Microsoft Kinect
v2 or Intel RealSense (F200 or R200) device.

Note: Also note that adding a third-party 3D sensor to a bundle is only possible in Artec
Studio Ultimate.

Use the following procedure to prepare the devices and the environment to simultane-
ously capture 3D reality:

1. Calibrate the relative position of each device (i.e., create a bundle)

2. Use the Multi panel to capture scans

To create a bundle, perform the following steps:

1. Capture the test object using all bundled scanners (see object requirements in Bun-
dle Creation)

2. Manually align the resulting scans using the Align tool to compute the relative po-
sition of all scanners

3. Create the bundle using the Create bundle panel
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Note: Once you have created the bundle, you can no longer move the scanners relative
to one another. If even one device has changed position, you must recreate the bundle!

9.2.1 Bundle Creation

Perform the following steps before creating a scanner bundle:

1. Select device positions. The scanners’ combined field of view should cover the
required area.

2. Fix the scanners in the chosen positions. If you plan to use hardware synchroniza-
tion (see EVA Scanners: Hardware Synchronization), attach the scanners to the tripods
by securing them with thumbscrews while allowing the wires to hang freely.

3. Select and set up the calibration object. Any object with a geometry-rich surface
is a candidate. Avoid selecting objects with simple geometries for calibration (e.g.,
planes, spheres or cylinders). You may use several objects as a composition when
creating a bundle. We recommend object installation at the distance corresponding
to the middle of the operating range for the corresponding device type.

You can perform the scan using the Capture or Multi panel. The latter option is more
convenient, as it allows you to capture the video data stream simultaneously from several
scanners. For details regarding this mode, see Performing Multicapture.

Figure 9.4.: Bundle-creation window.

If you install the scanners at small angles relative to each other (i.e., you can see the same
object area simultaneously through different scanners), you need not rotate the object.
In this case, you can take calibration scans either sequentially or concurrently.
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Note: In case of sequential scanning, make sure the object is fixed safely and remains
motionless during the scan.

If you set up the scanners at a large angle and their fields of view have no overlap, use
the Multi panel to start the capture sequence and then turn (move) the object to enable
all scanners to capture the same parts.

Note: It is important that all scanners capture a large portion of the object or scene (but
not necessarily the same portion) in each frame, because the position of all subsequent
frames—as well as the scanners themselves—will be determined by their predecessors.
Also, the relative positions of the scans will determine the intercalibration of the devices.

If the cameras are far from each other and the object was moving, then you should register
the scans using the Fine registration and Global registration algorithms. This requirement,
however, isn’t applicable for 3D sensors: running Global registration may spoil the scans
owing to low quality of the geometry obtained from the sensors.

4. Next, proceed to the Align panel and align the captured scans as Scan Alignment
describes. At that point, everything will be ready for bundle creation.

5. From the menu, select File→ Create bundle. A warning message will appear if you
forget to align the scans. Otherwise, the bundle-creation panel will appear (see
Figure 9.4.). The 3D View window will show the selected scans, the position and
viewing direction of the scanners (by means of an appropriately colored pyramid),
the device ID, and the scanner coordinates. It will display a list of connected devices
and corresponding information.

6. Add a device to the bundle or remove one by inverting the image in the leftmost
column of the list. The order of devices in a bundle refers to the scan order in the
Workspace panel.

7. A bundle name will appear in the field at the top of the bundle-creation panel. By
default it contains the serial number of the bundled scanner. Before creating the
bundle, you can easily change this name by typing in the corresponding field. Click
Apply at the bottom of the panel to create and install the bundle.

9.2.2 Performing Multicapture

Multi mode allows you to capture 3D-data streams simultaneously from several devices.
Selecting this mode activates the corresponding panel (see Figure 9.5.) and lets you
choose the device configuration: either use one of the existing bundles or specify the
scanner list manually.

Note: In multicapture mode the system possesses information about the relative scanner
positions. Therefore, scans captured by bundled scanners differ frommanual scans in that
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the matching frames from different scanners are already in the same coordinate system.

Warning: You cannot use a bundle if the number of devices it includes is greater
than the number of processor cores in your PC (i.e., a quad-core PC enables up to four
scanners in a bundle).

Figure 9.5.: Multicapture panel: Options tab on left, Device tab on right.

1. Select the Use bundle checkbox. A dropdown list of all installed bundles will appear
in the panel. Active bundles are highlighted in black, inactive bundles in gray. Artec
Studio considers the bundle active if all bundled devices are installed and connected
to the PC.

2. Select Synchronization type from the Options tab in the Multicapture panel.

• In Software mode, scanners are synchronized via USB, Windows and Artec Stu-
dio, and the slave-scanner actuation time always varies (~10 milliseconds) ow-
ing to the numerous links in the chain.

• In Hardware mode, scanners are synchronized via cables (see EVA Scanners:
Hardware Synchronization for details). Hardware synchronization provides high
precision and repeatability for slave-scanner actuation time (about 1 millisec-
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ond with a precision of less than 10 microseconds, thanks to microelectronic
processes).

Note: We recommend hardware synchronization in most circumstances; when cap-
turing moving objects, it is mandatory.

3. Click Preview to start capture.

Tweaking Multicapture Options

You can store multicapture data either as separate scans (use the Separate scans radio but-
ton) or as a single scan in which every frame represents an aligned union of corresponding
frames from all bundled devices (use the Merge frames radio button).

If you need to capture frames with a certain delay between the scanners, enter the delay
value in the Delay between frames field. Unlike the Scan mode, the Multicapture mode
captures each frame independently without attempting to align each subsequent frame
with the previous one, so it makes sense.

Sometimes, limiting the cameras’ field of view is necessary (e.g., to cut off extraneous dis-
tant objects). Two sliders in the Depth of field area set the near and far scanning bound-
aries. The application sets work-area boundaries for each device independently in the
device tabs (see Figure 9.5., right). By default, the minimum and maximum boundary val-
ues for the corresponding device type are set to the recommended range; we encourage
you to avoid changing them. However, if you’re using Artec L scanners or 3D sensors, it
may become necessary. To change these values manually, mark the Override default depth
range checkbox in the Scan tab of the Settings dialog and enter the appropriate values in
the fields below.

Note: For most scanner types, redefining the recommended depth range may reduce
accuracy.

If capture speed is crucial, enable Fast capture mode by checking the corresponding box
and entering the desired capture duration in seconds. In this mode, Artec Studio wastes
no processor time on building and rendering surfaces; instead, it stores raw data in mem-
ory and processes frames after completing the capture sequence. When you change the
duration of the fast capture period, the application will automatically recalculate and dis-
play the required amount of memory. Artec Studio saves multicapture parameters when
you exit the application and reapplies them the next time you start it.

9.3 Measurement Tools

Artec Studio offers a number of measurement and commenting tools, including

• Linear measure
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• Geodesic measure

• Sections (cross-sections)

• Surface-distance maps

• Annotations

The corresponding buttons reside in the upper part of theMeasures panel (see Figure 9.6.).

1. Choose a measurement tool, the application displays a list of scans you can work
with

2. Select the checkbox of each desired scan. The scans will appear in the 3D View
window.

3. Click Next. The selected measurement-tool window will open.

The coverage below takes a closer look at the different measurement tools and their
features.

Figure 9.6.: Measures panel.

Hint: If your Measurement panel lists the previously created items, you can open one of
them by double-clicking that item or clicking the Edit button.

9.3.1 Linear Distance

The linear-measurement tool (see Figure 9.7.) allows you to measure distances between
selected points and to measure the total length for a string of multiple points. Click the
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button and select the scan to switch to the Linear window. You can enter a name
for the new measurement by typing it in the Name field in the upper part of the window.
The application creates new measurements with default names Linear 1 , Linear 2
and so on.

To measure distances between points,

• Use LMB to sequentially select the points on the model in the 3D View window. The
application will add these points to the current point list, which will also display
linear dimensions and point coordinates.

• When you roll the cursor over any one of these points in the 3D View window, the
point will be highlighted in red; you can then drag it to another location using LMB
. When you release the mouse button, the point will fix to its new location.

Warning: You can’t set a point outside the object’s surface; in this
situation, if you release the mouse button, the point will return to its
original position.

The total number of points and total length of the measurements appear in the Measures
panel.

Table 9.1.: Basic operations in the linear and geodesic measurement modes.

Purpose Control Name
Hide scans in the 3D View Hide source data checkbox
Display order numbers of points Show numbers checkbox
Display dimension results in the 3D View Show labels checkbox
Specify the label and line color Color button
Start a new measurement chain on the same objects
(clear 3D View of all points and empty point list)

Make another button

Export measurements in a CSV or XML file Export button
Return to the original Measures tab Measurements link in the

upper part of the panel

After you click Apply, the application will return to the original Measures panel and will
display a list of all saved measurements along with editing and deletion options.

9.3.2 Geodesic Distance

Geodesic distance is defined as the length of the shortest path over a surface between

several given points. Click the button in the Measures panel and select a scan to
start using the tool.

Note: Only scans containing one surface will appear in the selection panel for the
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Figure 9.7.: Linear measurement.

geodesic measurement tool.

Working with geodesic measurements is similar to working with linear measurements
(see Figure 9.8.). Calculation of the shortest path is a time-consuming process that is
accompanied by a progress-bar window. Also keep inmind that the shortest path between
different surfaces or disconnected parts of the same surface is not defined. Therefore,
the program will display an error if you select points on parts of a surface that are not
connected to each other.

Figure 9.8.: Geodesic-distance measurement.

Note: The geodesic algorithm is complex, and computations for a large number of ver-
tices may take a long time. Therefore, if you choose the first point on a surface contain-
ing more than 150000 points total, the software will warn you that it may be a lengthy
operation. You can either use the mesh-optimization algorithm beforehand (see Mesh
Simplification) or delete the parts of the surface that you don’t need.

The left panel in this mode is similar to the one for linear-measurement mode (see Linear
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Distance).

9.3.3 Using Sections to Measure Area and Volume

To create a section of the object (see Figure 9.9.), click the button in the Measure-
ments panel and select one or more scans. After clicking Next, you can change the section
name in the Name field. By default, the application creates new sections with names
Section 1 , Section 2 and so on.

Figure 9.9.: Using sections.

Now you can define the section:

1. Use LMB to mark points on one or more surfaces:

(a) Mark only one point to specify a plane in parallel with one of the coordinate
planes (XOY, YOZ, XOZ).

(b) Mark three points to specify the plane that passes through them exactly.

(c) Mark more than three points to specify the plane that passing through their
center of mass.

2. Redefine your point selections, if necessary, before you use Create section; to do so,
click the Clear points button.

3. Click Create section. If necessary, redefine the plane. Click the Change position but-
ton and choose a tool: Translate, Rotate or Scale. You can either specify numerical
values (in the global coordinate system) in the text fields or drag the controls (see
Figure 8.6., Figure 8.7. and Figure 8.8.) in the 3D View windows. For instance, by
enlarging the Scale for the plane defined in Step 1.2, this plane would then cross
the whole surface. Confirm your changes by clicking Apply.
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4. Create a series of sections, if desired. To do so, specify the quantity of planes you
want to create by entering the value in Number of planes and define the spacing
in the Section spacing, mm field. Then select from the Direction list one of three
directions (Positive, Negative or Both) in which to create the new planes.

5. Save your changes by clicking Apply, or click Measurements in the upper part of the
panel. To save the changes and begin creating the next plane, click Make another
section.

Figure 9.10.: View of contours (from left to right): open contour (1), closed contour (2),
contour selected (3), pair of contours selected (4).

Figure 9.11.: View of meshes: one mesh selected on left and several on right.

Once you have created the section, the Section panel will display its geometrical informa-
tion. This information includes perimeter and area for closed contours as well as area and
volume for meshes. If the section object consists of several planes, the data is grouped by
plane. Besides displaying geometrical values, Artec Studio will show a list of meshes and
contours that allows you to highlight them in the 3D View window using different colors:

Blue (see image 1 in Figure 9.10.) if the contour is open.

Green (plain) (see image 2 in Figure 9.10.) if the contour is closed.

Green (highlighted) (see image 3 in Figure 9.10.) applies to the currently selected contour
or the polygons under (above) the selected plane. To toggle between polygons, click
the Invert direction button.

Pair of green highlighted contours (see image 4 in Figure 9.10.) highlights both contours
in the list if you selected a pair using Ctrl . Simultaneously, Artec Studio calculates
the differences between the areas and perimeters of these contours.

Several shades of red denote polygons belonging to one mesh (dark red in left image in
Figure 9.11.) or to several meshes (from brighter red to the brightest red in right
image in Figure 9.11.). When you have selected a pair of meshes, the application
also calculates the difference between volumes and areas and displays the results
in the lower part of the Section panel.

If you want to separate a set of sections into individual ones, click Convert to multiple
sections. The software will notify you that the operation was successful, and the new
objects will appear in the Measurements list.
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Exporting Sections

You can export sections in the following formats: CSV , XML or DXF .

• To export each section individually, enter the Section panel and click Export

• To export several objects at a time, access the original Measures panel, select the
checkbox next to desired sections and then click Export.

9.3.4 Surface-Distance Maps

You may often find it necessary to compare two models and assess the deviation of their
forms. For instance, quality control may require comparison of the original model with
the scanned one. You can handle these tasks by using Surface-distance map.

Note: Artec Studio can only compare models or scans containing a single surface.

Figure 9.12.: Specifying parameters for surface-distance map calculation.

Use this tool as follows:

1. Click the button from the Measures panel.

2. Select two models for comparison and click Next.

3. If necessary, specify the name of the distance map in the Name field of theMeasures
panel (see Figure 9.12.). By default the application creates new distance maps under
the names Map 1 , Map 2 and so on.

Note: The direction along the normals of the first scan is considered
positive; the opposite direction is considered negative. The button
swaps scans.
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4. Specify the Search distance (mm) value, a maximum range in millimeters for calcu-
lating distances between surfaces. You can adjust the actual range subject to this
maximum after the calculation finishes.

5. Click Calculate. Once the process is complete, the distance map will appear in the
3D View window and the calculation results in theMeasures panel (see Figure 9.13.).

Figure 9.13.: Surface-distance map calculated for two models.

You can analyze the calculation results and the distance map:

• On the basis of the Search distance value you entered, Artec Studio calculates the
following:

– RMS (root mean square)—the square root of the arithmetic mean of the squared
distances

– Mean absolute deviation

– Mean of signed distances

• A distance map is a colored rendering on the particular surface regions. You can
read the corresponding distance values and their distribution from the graduated
scale and histogram that appear adjacent to the model. The map color changes
from blue, which corresponds to a negative distance, to red, which corresponds
to a positive distance.

– Green means the distance between surfaces in this region is close to zero.

– Gray highlights any surfaces with distances that exceed the specified Search
distance.

– Orange and bright blue correspond respectively to distances that are
slightly above and below the limiting values of the scale.

• The graduated scale ranges from the positive value to the negative value of the
Error scale. You can adjust this range using the Error scale (mm) slider or text box.
Its maximum value cannot exceed the Search distance.

• If you move the mouse cursor to a particular point on the map, the exact distance
will appear nearby and in the Distance at cursor field in the left panel.
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To save the current distance map and quit this mode, click Apply. To save the current map
and create another one, click Make another map.

Note: Surface-distance maps are supported by annotations. You can use any saved
distance map in Annotation mode (see Annotations).

9.3.5 Annotations

Annotations tools allow you to mark noteworthy surfaces and surface-distance maps. The
annotation can include one or more labels, which look like rectangular tags with connect-
ing lines pointing to the corresponding surface elements (see Figure 9.14.).

To create an annotation,

1. Click the button in the Measures panel, then select one or more scans and click
Next.

(a) If you want to annotate a previously obtained surface-distance map, select it
from the Distance map list.

2. Specify the Annotation name in the upper part of the panel, or simply proceed with
your annotation using the default name.

3. Click LMB on the surface’s target point in the 3D View window; the label will appear
with a blinking text cursor in the Annotation text field of the Measures panel.

Note: Artec Studio doesn’t enable you to redefine a label’s target point.
If you inaccurately specify a point on the surface, add a new one (repeat
Step 3) and delete the old one (consult the instructions below).

4. Type any desired text for your annotation; this text will appear in both the corre-
sponding field in the panel and the label in the 3D View window.

5. Repeat Steps 3 and 4 to create a new label. In addition to tagging the surface,
each new label will appear in the annotation list of the Measures panel (see Figure
9.14.). You can show or hide labels in the list or change their colors by clicking
RMB and selecting the appropriate option from the menu. Alternatively, toggle
the selection flag or click the square button to show/hide labels or change their
colors, respectively.

You can adjust the label position (meaning the rectangular tag, not the target point!) by
holding LMB in the 3D View window while moving the mouse cursor. To delete unnec-
essary labels, use any of the following approaches:

• Select the label in the 3D View window; its border color will become red (see se-
lected label in Figure 9.14.). Hit the Del key.
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Figure 9.14.: Annotation of a model layered with a surface-distance map.

• Select the label from the list, then either hit Del , or click RMB and choose Delete
from the menu.

To export annotations (more precisely, label coordinates and titles) to a CSV or XML
file, click Export in either the Annotations or original Measures panel. By default, the file
name will be the same as the annotation name. Accept it or type in another name of your
choice. To complete the annotation, click Apply in the bottom of the Measures panel or
click Measurements in the upper part.
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CHAPTER 10

Settings

This chapter describes Artec Studio settings that you can change through the Settings
dialog. To display this dialog, select Settings... from the File menu or hit the F10 key.

The user-adjustable settings are divided into categories under separate tabs. These cat-
egories include the following:

• General

• Performance

• Scan

• UI

• Miscellaneous

10.1 General

The General tab contains basic Artec Studio settings and includes the following options
(see Figure 10.1.):

• Project-storage folder

• Autosave options

• Import/export options

• Default import units and Default export units

• View control settings

10.1.1 Project-Storage Path

You can set the default folder in which Artec Studio will save projects by typing in the
path, or select it from the dialog by clicking Browse....
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Figure 10.1.: General settings page.
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10.1.2 Autosave Options

When the Save project before starting algorithms option is enabled, the application will
always save your project before running any processing routines. The Restore loading state
of scans after algorithms finish checkbox allows you to control loading of selected scans
once the algorithm is complete. Artec Studio always loads selected scans into memory
before launching an algorithm; if a scan is not loaded at this point, the application will
automatically save it to the hard drive after the algorithm finishes, freeing up memory.
For more information about autosaving projects, see Autosaving a Project.

10.1.3 Registering Artec Studio as Default Viewer

Artec Studio supports various file formats. To make it the default application for sup-
ported formats, click Change... and select the formats you want the application to open
by default (see Figure 10.2.):

*.sproj —project files for Artec Studio

*.scan —single-scan export/import format

*.ply —format for saving polygonal models obtained using 3D scanners

*.stl —3D-model export format for fast-prototyping equipment

*.wrl —virtual-reality files in VRML 1.0 and VRML 2.0 format

*.obj —texturized 3D models; Wavefront OBJ format

Figure 10.2.: Making Artec Studio the default application for various file types.

For more information on importing and exporting files, see Exporting Models and Scans
and Importing Models and Scans.

10.1.4 Opening Files

Artec Studio can serve as the default viewer for SPROJ , SCAN , PLY , STL , OBJ and
VRML (*.wrm ) formats. To open each subsequent file in a new application window,
select Open new model in a new window. If the Open new model in the same window option
is selected, Artec Studio will use existing windows to display subsequent files.
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10.1.5 Surface-Consistency Detection During Import

The Surface-consistency detection during import option instructs Artec Studio to examine
imported files for defects. Select one of the following parameters:

Do not detect —disable automatic surface-consistency detection

Detect & ask —enable automatic surface-consistency detection; Artec Studio will prompt
you to start defect correction

Always detect & fix —enable automatic surface-consistency detection and correction

10.1.6 Model Placement

When exporting, the application can automatically center scans and models on the origin
of the axis grid. To enable this option, select the Move model to origin of the axis grid
during export checkbox. If the checkbox is cleared, the application will save the model’s
current placement on the axis grid when exporting surfaces.

10.1.7 Units

In Artec Studio, all software operations use millimeters as the default measurement unit.
If you need to import or export a model in other units, change the settings under Units.
The software applies these settings only when importing or exporting a model.

Selecting the Show unit-selection dialog on import option enables you to choose on import
which measurement unit was used to create the scan (see Figure 10.3.). Artec Studio
supports units of millimeters, centimeters, inches and meters. If in most cases you import
data in a particular measurement unit, but you might occasionally import models created
using another unit, you should enable the Only if object is less than __ mm option and enter
the threshold value. In this case, the unit-selection dialog will only appear if the model
dimensions are below the threshold value.

The Default import units and Default export units dropdown lists determine the default
measurement units for importing and exporting models.

Figure 10.3.: Unit-selection window.
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10.1.8 View-Control Settings

Artec Studio allows you to use Scroll wheel to zoom in on the model in the 3D View
window. You can take advantage of this capability in two ways:

Clear the Mouse-wheel zoom to cursor checkbox to enable zooming to the center of the
screen. In this case, you must keep the target area in the screen center and readjust
its position from time to time.

Select the Mouse-wheel zoom to cursor checkbox to enable interactive zooming to the
mouse-cursor position. In this mode, you need only keep the cursor on the target
area while spinning Scroll wheel forward and backward.

10.2 Performance

The following parameters are user adjustable by way of the Performance tab (see Figure
10.4.): multithreading, memory usage, command-history storage, compression levels for
stored data, texture-recording mode and Real-time fusion settings.

10.2.1 Multithreading

On computers that feature multicore processors, Artec Studio uses all cores by default.
If you would like to limit the number of cores the application employs, clear the Use all
available processor cores checkbox and enter the number of concurrent threads manually.

10.2.2 Memory

Under Memory, the Settings dialog shows RAM availability. If the current amount is insuf-
ficient, you can try to increase it by clicking the Compact memory button. Artec Studio will
clear the command history and attempt to optimize memory allocation. Clicking Compact
memory won’t permanently delete the history, but simply unload it from memory. The
Undo command will reload it. For more information about saving projects, see History of
Project Changes.

Note: You cannot unload the command history from memory if you haven’t saved the
project. Save the project and try again.

10.2.3 Command History

Under the Command history section you can limit the amount of history Artec Studio will
save. By default, the maximum values are set as a certain number of commands and size
on disk (in MB). If necessary, you can clear the Max history length checkbox. Doing so
means the program will save all history for each project from the beginning. You can
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Figure 10.4.: Performance-tab options.
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clear the project history by clicking the Clear command history button; the application will
prompt you to confirm this action.

Note: Once you clear the history, you cannot return to an earlier project version.

10.2.4 Data-Compression Level

The slider under Data-compression level allows you to change the amount of file com-
pression when saving data. Higher compression saves disk space, but loading and saving
these scans takes longer. These settings apply to both projects and SCAN files.

10.2.5 Texture-Recording Mode

By default (Automatic texture recording enabled), Artec Studio doesn’t capture texture for
every frame. You can, however, manually specify the frequency for capturing texture
frames by using the Record texture every __th frame spinner.

Figure 10.5.: Spinner for adjusting capture frequency of texture frames.

10.2.6 Real-Time Fusion Settings

Real-time fusion offers two optional settings (see Scanning With Real-Time Fusion):

Voxel size (mm) The fusion resolution. It affects the algorithm’s performance and quality.
The lower the value, the sharper the shape of the model. Note that specifying low
values may produce noisy surfaces.

Buffer size Amount of GPU memory employed to reconstruct a Real-time fusion object
in the scene. The default value depends on the computer’s available GPU memory.
Note that Artec Studio may fail to correctly determine the upper limit if your com-
puter has an Intel HD Graphics card. The more memory you have, the larger the
scene you can scan in Real-time fusion mode. The slider doesn’t define the total
finite memory size, however; the algorithm employs system memory (RAM) when
GPU memory is consumed.

Note: Avoid altering the Buffer size unless you have started noticing artefacts while
scanning.
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Table 10.1.: Default values of Voxel size.

Artec EVA Artec Spider Third-Party 3D Sensors
Voxel size (mm) 1 0.3 3

10.3 Scan

The Scan tab allows you to edit the parameters that the application uses both while scan-
ning and while postprocessing the results (see Figure 10.6.).

Figure 10.6.: Scan-settings tab.

10.3.1 Algorithm Settings

Artec Studio automatically selects and displays settings for each scanner type in the Cur-
rent scanner type dropdown. If it fails to correctly identify your scanner type, select the
appropriate scanner manually. While using the application, you may need to change al-
gorithm settings manually. To reset all settings to their default values, click Reset to
defaults.

Current user preset allows you to save the current parameter values in the Tools panel.
By selecting a saved preset, you can change all settings at once. Note that this option
applies only to the selected device type.

148 Chapter 10. Settings



Artec Studio, ver. 11

10.3.2 Photogrammetry Settings

Photogrammetry settings allow you to define the target size. Inner target diameter (mm)
corresponds to the diameter of the white circle in the middle of the target; Outer target
diameter (mm) corresponds to the outer diameter of the target’s black ring. The most
popular targets have diameters of 6 mm and 12 mm; the values 5 mm and 10 mm
correspond to the Scan Reference target. See Target-Assisted Scanning for details.

The Disable hybrid tracking for .obc checkbox ensures that tracking is purely based on
targets. Select the checkbox if you don’t want the texture and geometry features to assist
target scanning (Using Photogrammetry Solution (Scan Reference)).

10.3.3 Capture

The Capture section covers settings related to the trigger button for the Artec MHT scan-
ner, as well as the scanning-depth range and individual frames acquired during the scan.

The first option is the Trigger mode for device button checkbox, which changes the button
behavior on the Artec MH and Artec MHT scanners. For details regarding these buttons,
see Scanner Buttons and Capture Modes.

The scanner has a defined depth range. If it’s too close to the object, it may fail to cap-
ture all or part of the object. On the other hand, if the scanner is too far away, various
types of 3D “noise” will appear in the scene, complicating the postprocessing effort and
affecting the final results. Therefore, you should position the scanner as close as possible
to the object without crossing the cutoff plane. Default settings for each 3D scanner con-
tain minimum and maximum limits within which you can position the cutoff planes. The
scanner model determines these values. If you are using an Artec L scanner or 3D-sensor
and high accuracy is of lesser importance, however, you can adjust the depth boundaries
manually, allowing you to scan closer to or further from the object than the recommended
distances indicate. To this end, mark the Override default depth range checkbox and enter
new range values.

Warning: Redefining the depth range may reduce accuracy.

Scan Using Auto-Alignment

The Scan using auto-alignment option is enabled by default and is covered in the Resuming
Scan After Lost Tracking and Continue Scanning From Scans Selected in Workspace sections.
The application’s behavior varies depending on this option’s value, as Table 10.2. shows.
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Table 10.2.: Application behavior with option enabled and disabled.

Scan Using Auto-
Alignment On Off

Tracking Mode Geometry + Texture Geometry or Geometry +
Texture

Audio Notification? Yes (see Audio Notification) Yes

Message in 3D View Searching for position: Point 3D Scan-
ner at the object to continue

Tracking lost: Repeat scan
using slower motions or
additional features

Instructions

Direct the scanner at any already cap-
tured region with sufficient texture,
maintaining the original scanner orien-
tation relative to the object

Direct the scanner at the
last captured region

Data Recording Handled in a newly created scan Handled in the same scan

10.3.4 Misalignment Detection

In some cases, Artec Studio may incorrectly determine relative frame positions, result-
ing in misalignment. When this error occurs, you must restart the scanning session and
remove the misaligned scans. Alternatively, you can attempt to fix the misalignment by
breaking the scan into several segments. Further information about addressing this prob-
lem by dividing scans is available in Separating Scans. To prevent possible misalignment
and improve your scanning experience, Artec Studio features a Misalignment detection for
EVA scanner setting that functions during the scanning process. However, if you have
difficulty maintaining the tracking when scanning particular objects, you can disable this
setting.

Options are as follows:

On (Hybrid tracking only) —default value, option works for Geometry + Texture tracking
mode

On —option works for all tracking modes, including Geometry

Off —option is turned off for all trackers.

Default Capture Settings

Artec Studio allows you to change the characteristics of single-frame surfaces as the scan-
ner captures them. To change the default parameters, clear the Use default capture settings
checkbox and change the settings manually in the displayed window. The options below
are user adjustable:

Important: We recommend using default settings. Poorly chosen settings may reduce
data quality.
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Triangles step —point density for a frame mesh

Minimum object size —smallest object scanned, by number of polygons

Length filter threshold —triangle-filtration threshold by edge length (maximum possible
size in mm)

Interpolate —use interpolation for parts of surface that are missing data

Max interpolated length —maximum size of areas to be interpolated (in mm)

Max angle —triangle-filtration threshold by maximum angle (in degrees) between the
triangle’s normal and the camera’s sight vector

Geometry registration threshold —the higher the threshold, the stricter the quality re-
quirements for the geometry being scanned. Therefore, determining the proper ge-
ometry in the scene is more difficult in such cases. Subsequently, Artec Studio runs
geometry registration less frequently, making way for texture registration. Works
with Geometry + Texture tracking only, values are between 0 and 1.

10.4 UI

The UI page allows you to edit user-interface settings (see Figure 10.7.) and covers the
following categories:

• Audio notification

• Workspace colors

• Warnings

• Surfaces that Artec Studio displays during a scan

10.4.1 Audio Notification

Sometimes, automatic alignment in real time is impossible during the scanning process,
and the program is unable to align the previous frame with the current one (see Resuming
Scan After Lost Tracking). When this situation occurs, Artec Studio issues an audio warning
that stops once you reposition the scanner and the software again finds its location in 3D.
To enable or disable this feature, use the Enable audio warnings in scan mode checkbox.
A standard “beep-sound” is the application’s default sound. You can choose any WAV file
as the warning sound. To this end, click the ... and specify a file path.

Note: You will only receive audio warnings during a scan if your computer is equipped
with a sound card and speakers.
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Figure 10.7.: Interface-settings tab.
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10.4.2 Workspace Colors

Artec Studio automatically chooses display colors for newly created scans. You can select
any of the standard palettes:

• Full palette

• Light colors

• Web-safe colors

• Random colors

• Monochrome

10.4.3 Warnings

The Warnings options allow you to toggle certain notifications. They include the follow-
ing:

Warn on exit if project has unsaved changes. If this option is enabled, Artec Studio will
warn you that you will lose unsaved data if you close the application without saving
your work.

Show OpenGL compatibility issues on startup. Artec Studio requires OpenGL version 2.0
and some OpenGL extensions to function properly; your PC may or may not cur-
rently support these capabilities. Selecting this option activates a display window
on startup containing information regarding possible missing extensions.

Texture-healing brush: warn if over __ polygons selected. This checkbox instructs the
application to display a warning if you exceed the maximum number of polygons to
be inpainted at one time. This limit reduces the potential for the computer to hang
up. Specify a suitable value for your system, or clear this checkbox if you require no
warnings of this kind.

10.4.4 Displaying in 3D View Window

You can change the way you see surfaces and points during the scanning process, adjust
their colors as well as the background color, and specify the mode for frame playback. To
these ends, use the settings below:

Display

Last scanned surfaces —number of visible surfaces most recently captured that will ap-
pear in 3D View during scan

Visible surfaces —total number of visible surfaces displayed during scan (equal to the
number of most recently scanned surfaces plus the number of key frames to display)
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Simple rendering mode threshold —maximum number of vertices in the viewport beyond
which Artec Studio will switch to simple rendering mode during 3D navigation

Point size —number of pixels for rendering each point when using the Points or the Points
and solid rendering mode

Colors

Last —color of last scanned surfaces

Registered —color of correctly aligned surfaces

Preview —color of surfaces in preview mode

Dropped —color of unaligned (and thus dropped) surfaces

Key frames —color of key frames (surfaces)

Playback

See also:

Selecting Data

Repeat —continuously loop the frame sequence in the surface-view mode of the
Workspace panel

FPS —speed (in frames per second) at which frames appear during playback

Background

See also:

Figure 10.8.

Color —background color

Dropped color —background color when misalignment occurs while scanning

Texture —display patterned (chessboard pattern) or plain background

Gradient —gradient or monochrome background color

Welcome Screen

Don’t show —disable the welcome screen

Autopilot

Don’t show greeting screen —disable the Autopilot screen showing the steps to pass in
this mode
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Figure 10.8.: Example of altered background.

10.5 Miscellaneous

10.5.1 Usage Information

You can help us improve the quality and performance of Artec Studio by allowing us to
collect and send usage information to Artec Group. This information will not be used to
identify you, and it excludes your project data, 3D surfaces, textures and any other data
that you obtain and process using Artec Studio. By default, the Collect and send anonymous
usage data to Artec checkbox is selected. We recommend leaving this checkbox marked
so we can better improve the application.

When installing Artec Studio, you can decide whether you want it to collect and send
usage data. The same checkbox described above also appears in the final installation
dialog (see Figure 4.13.).

Figure 10.9.: Miscellaneous-settings tab.
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10.5.2 Language

The Artec Studio interface supports several languages:

• Auto—automatic language selection on the basis of system settings

• Chinese (Simplified)

• Chinese (Traditional)

• Czech

• English (U.S.)

• French

• German

• Italian

• Japanese

• Polish

• Russian

• Spanish

To switch between languages, choose the one you want and click OK. The program will
then prompt you to restart. If you agree, the application will restart automatically using
the newly selected interface language. If you choose not to restart, the changes will take
effect the next time you start the application.

Note: To change the language, Artec Studio must restart.
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Scanner Calibration and Correction

The Diagnostic Tool is a special utility that enables you to calibrate Artec 3D scanners
and correct an existing calibration. In general, calibration is the process of checking and
adjusting a scanner’s measurements by comparing themwith the standard (etalon) values.
Every Artec scanner is delivered pre-calibrated.

In some cases, owing to careless handling or transportation (jolts, accidental drops or
some other reason), the scanner may fail to capture surfaces properly. The scanned sur-
faces may only be partially reconstructed or may contain holes (for example, the results
of bad reconstruction are noticeable on the blue surface in Figure 11.5.). You can resolve
these issues by correcting or calibrating the scanner.

Depending on the scanner model, the Diagnostic Tool can operate in one of the three
working modes:

• Correction for Artec MHT, Artec MH, Artec L and Artec EVA scanners

• Correction for Artec Spider scanner

• Calibration of Artec Spider scanner

Note: Calibration is available only for Artec Spider scanners.

11.1 Suggestions for Use

Correction differs from calibration in that it preserves the current calibration: it only
changes the correction ratio so as to enable good reconstruction. Application of this pro-
cess does not guarantee that captured geometric shapes and linear measurements will
be accurate.
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Table 11.1.: Correction versus calibration.

Mode Characteristics Speed For Spider? For EVA, L, MHT?
Correction Inexact Fast Yes Yes
Calibration Exact 1 Prep required Yes No

11.2 Launching Diagnostic Tool

To launch the Diagnostic Tool, first ensure that the scanner you intend to diagnose ap-
pears in Artec Installation Center as either Rented or Activated. You can launch the tool
either through the Start menu by clicking Start → All Programs → Artec Group → Artec
Studio→ Diagnostic Tool or in Artec Studio by selecting the Run Diagnostic Tool command
from the File menu.

If you have several scanners connected, select the appropriate one from the dropdown
list.

Figure 11.1.: Diagnostic Tool window.

The utility window contains three sections: the 3D View panel, the right panel and the
toolbar (see Figure 11.1.).

1 Restores the device to its original factory settings.
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11.3 Scanner Correction

11.3.1 Correcting Calibration Data for EVA, MHT, MH and L Scan-
ners

The Artec EVA, Artec MHT, Artec MH and Artec L scanners only allow you to correct the
current calibration settings.

Figure 11.2.: Artec EVA correction results.

1. Launch the Diagnostic Tool as Launching Diagnostic Tool describes.

2. Select the scanner you want to diagnose.

3. Click Start diagnostic or press the button. The scanner will start the preview, a
range meter will appear in the 3D View window and another panel will appear on
the right showing a 2D camera preview.

4. Direct the scanner at the right angle to a flat, light (but not shiny) monochrome
surface (e.g., a wall or floor) from a distance of 650–700 mm for an Artec MHT,
Artec MH or Artec EVA scanner or a distance of 850–900 mm for an Artec L scanner.
The tool will render the surface in blue in the 3D View window.

Note: If the rendered surface is not flat and contains holes, the correction is worth
performing.

5. Click Start correction or press the button on the scanner. In addition to the blue
surface, a yellow surface will appear in the 3D View window. Blue corresponds to
the surface captured using the original calibration data; yellow corresponds to the
surface captured using corrected calibration data.
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6. Two indicators in the right panel can help you assess the surface quality (green
stands for good results, yellow for satisfactory and red for unsatisfactory). If the
corrected (yellow) surface has no holes and is sufficiently flat, and if the correction
results meet your expectations, click Commit or press the button on the scanner.
Otherwise, click Rollback or press on the scanner.

11.3.2 Correcting Calibration Data for Spider

Correction for Artec Spider differs slightly from correction for Artec MHT and Artec EVA
scanners.

Figure 11.3.: Artec Spider correction process.

1. Launch the Diagnostic Tool as Launching Diagnostic Tool describes.

2. Select Artec Spider from the dropdown list.

3. Click Start diagnostic or press the button; the scanner will start the preview, a
range meter will appear in the 3D View window and another panel will appear on
the right showing a 2D camera preview.

4. Direct the scanner at the right angle to a flat light monochrome surface (e.g., a wall)
from a distance of 190–270 mm. The tool will render the surface in blue in the 3D
View window.

Note: If the surface, when captured from a distance within the sug-
gested range, fails to render as flat or contains holes, correction is worth
performing.
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5. Place the scanner on a desk or attach it to a tripod, keeping a distance of about 190
mm from the flat surface (see the range meter in the 3D View window).

6. Click Start correction or press the button on the scanner. A red mark will appear
on the range meter.

7. Move the scanner smoothly toward the flat surface such that the histogram peak
coincides with the red mark on the range meter (see Figure 11.4.).

8. Look for a new red mark to appear higher on the range meter. Smoothly move the
scanner away from the flat surface to approach the red mark.

9. Repeat Step 8 three more times. Once you finish, the calculation will start. A yellow
plane that corresponds to the surface you captured using the corrected calibration
settings will then appear in the 3D View window (see Figure 11.5.).

10. If the yellow surface has no holes and is sufficiently flat, and if the correction results
meet your expectations, click Commit or press the button on the scanner. Oth-
erwise, repeat Steps 7–9, click Rollback or press on the scanner. Two indicators
on the right panel can help you assess the surface quality (green stands for good
results, yellow for satisfactory and red for unsatisfactory).

Figure 11.4.: Artec Spider scanner’s position and corresponding distance on the range
meter.

Approaching the read mark (at the top), reaching the required distance (at the bottom).

11.4 Spider Calibration

To carry out the calibration, you will need the following additional equipment: a calibra-
tion rig, a scanner stand and a pattern. Assembly instructions for the scanner stand and
calibration rig appear in Assembling the Scanner Stand and Assembling the Calibration Rig,
respectively.
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Figure 11.5.: Artec Spider correction results.

Figure 11.6.: Scanner stand resting on a pattern.

Figure 11.7.: Placing Artec Spider on the stand
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Figure 11.8.: Calibration rig, pattern and scanner stand with Artec Spider.

1. Unfold the pattern and place it on a desk or any hard, planar surface.

2. Align the scanner stand with the rectangle marked on the pattern, paying close
attention to the orientation of the slots in the stand cover (see Figure 11.6.).

3. Place the scanner on the scanner stand, making sure that you insert the three scan-
ner stems in the three slots of the stand cover (see Figure 11.7.).

4. Set the calibration rig on the pattern, turning its marker side toward the scanner as
Figure 11.8. shows.

5. Launch the Diagnostic Tool as Launching Diagnostic Tool describes.

Note: You should conduct the calibration only after the scanner has
warmed to the optimal temperature.

6. Click Start calibration. A dialog box will open (see Figure 11.9.); enter the serial
number of your calibration rig (it appears on the board). If the scanner tempera-
ture is outside the optimal range—for example, you just connected the device to
a power outlet—the tool will notify you of this condition (see Figure 11.10.). We
advise against clicking Skip and instead recommend waiting for the Artec Spider to
reach its optimal temperature.

7. Place the rig in its initial position such that the front edge of its base coincides
with the color line numbered 1 on the pattern. As you do so, also keep an eye on
the 3D View window for a red plane (current position) and a green plane (target
position)—see Figure 11.11.. Once the red plane coincides with the green one, stop
moving the rig and wait for the scanner to capture the plane.

8. Wait for the tool to instruct you to move the rig to the next position on the pattern;
the number for that position will appear on the screen. Move the rig and again wait
for the scanner to capture the plane.

9. Repeat the preceding step for the remaining positions sequentially. Depending on
the version of your calibration kit, the pattern will have 11 to 15 positions.
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10. Once you have captured the last position and the calculations have concluded, a
message will appear prompting you to either overwrite the existing calibration or
keep the current one. Before you decide, direct the scanner at a flat, nonglossy
surface (e.g., a piece of paper) from a distance of about 200 mm. Assess the quality
of the reconstructed surface and check for any holes.

11. Click Yes, apply the calibration if no holes appear on the surface and you are satisfied
with the reconstruction results. To reject the new calibration, click No, keep the old
one (see Figure 11.12.).

Figure 11.9.: Entering serial number of calibration board.

Figure 11.10.: Warming up the scanner.

Figure 11.11.: Moving calibration rig to position number 1.

11.5 Notes Regarding Scanner-Calibration Files

Calibration and correction results reside in files that you can access as follows. Their
location is
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Figure 11.12.: Assessing calibration results.

C:\Users\%name%\AppData\Roaming\Artec\Artec Installation Center
\Devices\SP.00.00000000.

Here, %name% is the current user folder and SP.00.00000000 is the folder correspond-
ing to the scanner serial number. Note the following information regarding calibration
and correction.

• Once you apply correction results, the software will create an ACD file.

• Once you apply calibration results, the software will create ACD and CORR files.

• All newly created files have names of the form YYYYMMDD_HHMMSS , with the char-
acters corresponding to the date and time of the file’s creation.

• Original ADD and CORR file names are based on the scanner serial number and
have the form SP.00.00000000 .

Note: You can restore the initial calibration by removing the ACD and CORR files whose
names have the form 20131121_101010 .

Note: If you use the scanner on several computers, you need not recalibrate it on every
one. Simply copying the ACD and CORR files to the above-mentioned folder on each
computer may be sufficient.

11.6 Assembling the Scanner Stand

The scanner stand comes unassembled with Artec Spider and consists of five parts (see
Figure 11.13.): two side walls, one front and one back wall (these parts are identical,
however), and a cover. Before beginning assembly, lay them all out as Figure 11.13.
shows. Then follow these steps:
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Figure 11.13.: Parts of the scanner stand.

1. Raise the two side walls to the upright position, as Figure 11.14. shows. Noting
carefully the orientation of the T-shaped slot, install the front wall to the side walls
using the two pairs of hooks. Press the front wall and slide it down against the stop.
Make sure the three walls are properly aligned with each other.

2. Install the back wall in the same way (see Figure 11.15.).

3. Paying attention to orientation of the slots, install the cover using the upper hooks
of the side walls (see Figure 11.16.).

4. Press your thumbs against the T-shaped holes on the cover and shift it toward the
back wall until you hear a click (see Figure 11.17.).

Figure 11.14.: Assembling the front wall.

The scanner stand is now ready to use.

Note: To disassemble the stand, release the detents in the cover’s T-shaped slots (see Fig-
ure 11.13.) using a thin object like a ballpoint pen. Repeat the assembly steps in reverse
order (from Figure 11.17. to Figure 11.14.), moving the parts in the opposite directions.
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Figure 11.15.: Assembling the back wall.

Figure 11.16.: Mounting the cover.

Figure 11.17.: Latching the cover.

11.6. Assembling the Scanner Stand 167



Artec Studio, ver. 11

11.7 Assembling the Calibration Rig

The calibration rig comes only with Artec Spider and consists of the base and the board.
To assemble the rig, follow these instructions:

1. Press the hinge of the base against your forefingers.

2. Unfold the bent leaves of the base, pressing on their edges with your thumbs.

3. Insert the board into the slot, as Figure 11.18. shows.

Figure 11.18.: Assembling the rig.
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Appendices

12.1 Hot Keys

Table 12.1.: Hot key combinations.

Hot Key Function Where to Press
1 or Ctrl+Shift+1 Switch viewpoint to front 3D View window
Ctrl+1 Switch viewpoint to back 3D View window
3 or Ctrl+Shift+3 Switch viewpoint to left 3D View window
Ctrl+3 Switch viewpoint to right 3D View window
7 or Ctrl+Shift+7 Switch viewpoint to top 3D View window
Ctrl+7 Switch viewpoint to bottom 3D View window
5 (numpad) or
Ctrl+5

Toggle between perspective and or-
thogonal views 3D View window

F7 Start scanning (activate Preview mode) Anywhere exc. modal dia-
log

Space
Toggle between Preview and Record
modes Scan panel

F8 Open Multicapture panel Anywhere exc. modal dia-
log

F9 Open Autopilot Anywhere exc. modal dia-
log

Ctrl+G
Start automatic processing (don’t con-
fuse with Autopilot)

Anywhere exc. modal dia-
log

F10 Call Settings dialog Anywhere exc. modal dia-
log

F11 Show/hide Workspace panel Anywhere exc. modal dia-
log

Ctrl+Alt+L Show/hide Log window Anywhere exc. modal dia-
log

Ctrl+Shift+S Save screenshot Anywhere

Ctrl+N Create new project Anywhere exc. modal dia-
log
Continued on next page

169



Artec Studio, ver. 11

Table 12.1 -- continued from previous page
Hot Key Function Where to Press

Ctrl+S Save project Anywhere exc. modal dia-
log

Ctrl+O Open existing project Anywhere exc. modal dia-
log

Ctrl+Shift+O
Open existing project with scans un-
loaded (to save memory)

Anywhere exc. modal dia-
log

Ctrl+I Import 3D files Anywhere exc. modal dia-
log

Ctrl+Alt+H Clear command history Anywhere exc. modal dia-
log

N Display/hide normals Anywhere
B Display/hide boundaries Anywhere
F1 Open web manual Anywhere
Ctrl+F1 Open local User Guide file Anywhere

Ctrl+T Open Tools panel Anywhere exc. modal dia-
log

Ctrl+L Open Align panel Anywhere exc. modal dia-
log

1 Display aligned scans/models Align panel
2 Display unaligned scans/models Align panel
3 Display all scans selected for alignment Align panel
Shift Manually align scans Align panel
Space and
Backspace

Switch between point sets/pairs Align panel → points

Space Confirm creation of point set Align panel → Complex

Ctrl+B Open Edges panel Anywhere exc. modal dia-
log

Ctrl+R Open Repair panel Anywhere exc. modal dia-
log

Ctrl+M Open Measures panel Anywhere exc. modal dia-
log

Ctrl+U Open Texture panel Anywhere exc. modal dia-
log

Ctrl+E Open Editor panel Anywhere exc. modal dia-
log

P Start Positioning tool Editor panel
T Start Transformation tool Editor panel
T Enable Translate transformation Editor → Transformation
R Enable Rotate transformation Editor → Transformation
S Enable Scale transformation Editor → Transformation

X
Translate (rotate/scale) the model
along (around/in direction of) X axis

Editor→ Transformation→
any mode → 3D View

Y
Translate (rotate/scale) the model
along (around/in direction of) Y axis

Editor→ Transformation→
any mode → 3D View
Continued on next page
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Table 12.1 -- continued from previous page
Hot Key Function Where to Press

Z
Translate (rotate/scale) the model
along (around/in direction of) Z axis

Editor→ Transformation→
any mode → 3D View

S Start Smoothing brush Editor panel
E Start Eraser tool Editor panel
Ctrl+Shift+Scroll
Wheel

Move cutoff plane Editor panel → cutoff-
plane selection

D Start Defeature brush Editor panel
Ctrl+[ and Ctrl+]
or Scroll Wheel

Change tool size Editor panel → any tool

Ctrl+Alt+LMB Invert selection of 3D regions Editor panel → any tool →
3D View

Ctrl+Alt+LMB Select one scan and deselect the rest Workspace panel

Ctrl+LMB Select one scan and deselect the rest Workspace panel, first col-
umn

Shift+Alt+LMB Select/deselect scan Workspace panel
Ctrl+A Select all scans/models or frames Workspace panel
Ctrl+D Deselect all scans/models Workspace panel
Ctrl+Alt+A Invert selection of scans/models Workspace panel
F2 Rename scan/model Workspace panel
Ctrl+P Start/stop playback scan frames Workspace panel

Del Delete selected frames/scans Workspace panel (includ-
ing surface list)

12.2 Third-Party 3D Sensors

Figure 12.1.: Microsoft Kinect v1

Figure 12.2.: Microsoft Kinect v2
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Figure 12.3.: Asus Xtion (Primesense Carmine)

Figure 12.4.: Intel RealSense 3D camera by Creative (F200)

Figure 12.5.: Laptop featuring Intel RealSense 3D camera

Figure 12.6.: Operating ranges and fields of view for third-party 3D sensors.
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Index

Accuracy, 114
accuracy (general term), 14
Autopilot, 14

buffer size, 147
bundle, 14
By_radius, 109

CAD model, 15

error, 114

Fill_holes, 109
Filter_by_threshold, 111
fine registration, 15
force_constraints, 116
frames, 15

Geometry
for Fine registration, 91
for Global registration, 105

global registration, 15

iterations, 105

keep_boundary, 115
key frames, 15

Leave_biggest_objects, 111
loop_closure, 91

Manually, 109
max_hole_len, 114
max_hole_radius, 109
max_neighb_normals_angle, 115
mesh, 15

minimal_distance, 105
mode, 111
model, 15

near and far cutting planes, 15

project, 15

radius, 109
refine_serial, 91
registration_algorithm

for Fine registration, 91
for Global registration, 105

Remesh, 114
remesh_edge_thr, 114
remove_targets, 109
resolution

for Fusion, 109
for Outlier removal, 107

resolution (general term), 15
rough registration, 15

scan, 15
std_dev_mul_threshold, 107
steps, 114
stop_condition value, 114

targets, 15
Texture_and_Geometry

for Fine registration, 91
for Global registration, 105

threshold, 111
tracking, 15
tri_num

for Fast mesh simplification, 116
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for Mesh simplification, 114
Triangle_quantity, 114

UV_Triangle_quantity, 114
UV_Vertex_quantity, 114

voxel size, 147
vrt_num, 114

Watertight, 109
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